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10 SVP
10.1 How to Operate the SVP (PC)

This manual describes how to operate the SVP (PC) with the trackball or touchpad.

10.1.1 How to use a trackball
a) If SVP model is Armada or Contura.

\ \H_H_ﬂ_“ N A,,/
R

\

|
N\
o @ ®
@ : Trackball
Rotate this device to move the pointer to a desired position.

@ : Button
Pressing this button selects an item on which the pointer is placed.

® : Not used

b) If SVP model! is Flora

/ N\

@ ®

® : Touchpad

Trace this device to move the pointer to a desired position.
@ : Button

Pressing this button selects an item on which the pointer is placed.
® : Not used

Copyright ©1995,1998, Hitachi, Ltd.
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10.1.2 Windows Screen Component Nomenclature
Either of the following windows is displayed.

(1) Windows3.1

~

Program Manager

~

_ft‘File(E) Options(Q) Window(W) Help( H)

N OTitle bar
= SVP va
| @Menu bar
Online Information Install Diag \ ‘@ ®Border (frame)
@Application icon
(screen)
Status Fdcopy
MAIN

®GWindow (entire box)

®Control menu box

@Group icon
(2) Windows95
Hal 52
BellipTes  Dichenly
DiTarmel
!
—— @Desktop
@ @Window (entire box)
Infoem
®Border (frame)
ﬁm Orline @Menu bar
1 obj selec €] es Y
] objecllz) selected H342byles ™ ®Title bar
&
Wi ®Aplication icon
s (screen)
.
7]
&P
R stan| [V EEE PS5 s@n || TJ0um LG |[EiMantensnc | [BS 1043aM ]
- e - — X @Control menu box
®Task bar
®Start button
Copyright ©1995,1996, Hitachi, Ltd.
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10.1.3 How to use Windows

(1) Notation

In this manual, “select” has the following three meanings, and (CL), (DC), or (DR) is added to the word for each

meaning.

(CL) Click:

Quickly press and release the button above the trackball or touchpad.

(DC) Double-click:

Click the button above the trackball or touchpad twice in rapid succession.

(DR) Drag:

To hold down the button above the trackball or touchpad while you rotate the trackball or trace the touchpad to

move the pointer to a desired position. Then release the button.

example)

Select (DC) the [Install] icon in the ‘SVP’ window.

Move the pointer to [Install] with the trackball or touchpad. Then click the button above the trackball or touchpad

twice in rapid succession.

(2) Close

“Close” means to close the aplication window.
(Double-click the control menu box of the window or click the close button for Windows 95.)

*« Windows 3.1
/Control menu box
s SVP ey

* Windows 95
’ Control menu box

File Edt View Help

.

Install Diag [nbarmation
]
Online Status Fdcopy

342 bytes

Close button

Copyright ©1995,1998, Hitachi, Ltd.
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(3) Moving the Window
Move the pointer to the title bar with the trackball or touchpad.
While pressing the button, move the window with the trackball or touchpad (DR) to a desired position and release
the button.

= SVP ¢

Title bar

(4) Changing the window size
Move the pointer to the window border (frame) (the pointer changes to the double- headed arrow). While pressing
the button, move the border (the border changes to the broken line) until the window becomes a desired size, and
release the button.

= SVP oo |l

Border (frame)

(5) Switching the screen (when two or more screens are opened)

While pressing the key, press (or ) until your desired window title is displayed, and release the

key.

Copyright ©1995,1998, Hitachi, Lid.
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10.1.4 Power On
Usually, SVP start automatically at the breakers-ON.
If some problem occurred and you must start SVP, do as following procedures.

(1) Power On SVP
a. Press Power Switch on the SVP keyboard.
b. Watch messages displayed on the SVP screen.
If following messages are displayed, Go to (2).
Otherwise, power off (press Alt + Ctrl + Power Switch when SVP model is Armada or Contura. press Power Switch
when SVP model is Flora.) and on SVP to retry. (*1)
After retrying twice, replace SVP.

[Message]
xxxx KB OK
Starting MS-DOS or Starting Windows95
(Some other messages)

(2) Windows Start (SVP Start)
a. Wait a few minutes until Windows system will start.
b. Read message displayed on the SVP screen. (Go to SVPMSG section)
Otherwise, power off (press Alt + Ctrl + Power Switch when SVP model is Armada or Contura. press Power Switch
when SVP model is Flora.) and on SVP to retry. (*1)
After retrying twice, replace SVP.
[End of Power On]

*1:If SVP model is Armada or Contura.
If you press only Power Switch on the SVP keyboard when SVP and Windows system are active, these systems
will be frozen.
You should be sure to press Alt + Ctrl + Power Switch for power off SVP,

*2:If Windows95 doesn’t start, check the following items.
(1) Is the DKC “CE mode”?
(2) The two LED:s at the LAN cable socket are always on?
If above two conditions are satisfied, pull out LAN cable until Windows95 is starting.

Power Switch Power Switch

S —

Ctrl-key g Alt-key
Fig.a SVP model is Armada or Contura Fig.b SVP model is Flora

Copyright ©1995,1998, Hitachi, Ltd.
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10.1.5 Power Off
) What is running?
a. See what is displayed.
If Windows is displayed, Go to (2).
If DOS prompt is displayed, like “C:\>", Go to (4).
Otherwise, Go to (3).

(2) Exit Windows(Stop SVP)

If the “Task bar” is displayed, go to e.

(See the figure in subsection 10.1.2 (2) for the “Task bar”.)

a. Select “Program Manager” window.

b. Press Alt-key and F4-key. (Or select ‘File-Exit Windows’ menu.)

Select(CL) [OK] to agree to exit Windows.

Go to (4).

Select (CL) “Start button”.

Select (CL) “Shut Down”.

. Select (CL) “Shut Down the computer?”, and Select (CL) [Yes].
[End of Power Off]

© e Ao

(3) Stop Any Program
a. Press 2 keys simultaneously — Ctrl-key and ‘C’ — to stop program.
If DOS prompt is displayed, Go to (4).
b. Press 3 keys simultaneously — Ctrl-key, Alt-key and Del-key — to reboot SVP.
¢. Wait until SVP restart, or any problem occurs.
d. Goto (1).

(4) Power Off SVP

a. Press 2 keys — Citrl-key and Alt-key —, and Power Switch simultaneously when SVP model is Armada or
Contura. Press Power Switch when SVP model is Flora.
[End of Power Off]

Note : Do not press only Power Switch key when SVP model is Armada or Contura.
Because, since SVP does not stop to perfection, we do not guarantee the operation of SVP after re-power on.
If only Power Switch key was pressed, please power off SVP (see 10.1.5 (4) Power Off SVP).

Power Switch — Delete-key Power Switch
Y —
Ctrrkey —/  \— Alt-key
Fig.a SVP model is Armada or Contura Fig.b SVP model is Flora

Copyright ©1995,1998, Hitachi, Ltd.

BEV.G ” Jul.1995 |Sep.1995|Dec.1995|Dec.1996|Jun.1997|Dec.19¥| SVPO1 _60




K6600890-

10.1.6 Mode

(1) View Mode
In view mode, only referring the subsystem status can be allowed.

(2) Modify Mode
In modify mode, referring and changing the subsystem status can be allowed.

For example, log/pin data indication and status display on on-line are available in any mode, but replacement is
available in only modify mode.

Install, On-line, Information and Diag windows have the modes and when each window is opened the default value
is view mode.

Note : When there is no window in modify mode, pending SIMs (if exist) are reported to host.

Copyright ©1996, Hitachi, Ltd.
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10.1.7 Run

(1) <Select the [Run]>

* Windows3.1

Select (CL) the [File] menu in the ‘Program manager’ window and select (CL) the [Run...].

Program Manager

=]

{1 Options Window Help
New...

Open Enter
Move... F7

Copy... F8

Delete Del
Properties... Alt+Enter
Exit Windows...

« Windows95

Select (CL) the [Run...] in the [Start button)].

Copyright ©1996, Hitachi, Ltd.
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(2) <Input file name>

» Windows3.1
Input file name in ‘Command Line’ and select (CL) [OK].

Command Line:

[J Run Minimized

» Windows95
Input file name in ‘Open’ and select (CL) [OK].

Run
% Type the name of a program, folder, or document, and

e Windows will open it for you.

Open: [a\ ]

[ 0K [ cancel || Browse.. |

SVP01-90
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10.1.8 Screen Saver, and SVP reboot function
This function executes SVP reboot at intervals of a certain duration, one time per day.
Normally, the function displays a2 new windows for Screen Saver.

(1) SVP (PC) reboot
When SVP detects the reboot time under displaying the Screen Saver, the function will reboot SVP automatically.
But, if other applications of SVP are executing, the function will stop rebooting, and wait until the next time will
arrive,

(2) Screen Saver
1. If there is no access from keyboard or mouse during 60 minutes, and other SVP applications windows are closed,
SVP will open the screen saver window.

PC Watch

SVP Screen Saver

This window is SVP Screen Saver.
If you operate, please press any key.
The window will be closed by itself.

[Press Any Key]

2. Normally, the function becomes icon.

Copyright ©1997, Hitachi, Ltd.
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(3) Setting reboot timer
1. Please select “PC Watch” Icon (DC).

H4

wid
it
Kl

MR 0IFT
NINDOWNS

FC wiatch

2. SVP will displays “Input Password” screen.
Please enter the password and select “OK” (CL).

= Input Password

Password:

tmn‘

oK

3. Next, SVP will displays “Set Reboot Parameter” Screen.
Please input Reboot interval and Reboot time, and select “OK™ (CL).

-— Set Reboot Parameter

@ Reboot Interval

~Reboot Interval Reboot Time
Every Day : one time per day. .
. i @ Every Day Hour :
Not Reboot : not available to reboot. Min. :
@ Reboot Time O Not Reboot o
Reboot time will be set. 00:30-23:30
Notice: Cancel

The SVP usually receives a TH/ORM log data from
DKC-Main at 23:30 - 0:30, so that you can not input
those time.

= Set Reboot Parameter

If you input the reboot time as 24:00 or above timer

23:30 - 0:30, will move the focus. Reboot Interval

@ Every Day
O Not Reboot

Reboot Time

Hour :
Min. :

00:30-23:30

Cancel

Copyright 1997, Hitachi, Ltd.
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10.2 Function of the SVP
10.2.1 TOD (Time Or Date) setting

(1) Select (DC) the [Install] icon in the ‘SVP’ window.

information Status
Floory (RN

Diag

Online

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright [C) 1994,1995,Hitachi,Ltd.

OK

(3) Select (CL) the [Mode] menu in the ‘Install’ window and
select (DR) [Modify).

Install

File Install JXETE

(4) Select (CL) the [Install] menu in the ‘Install’ window and
select (DR) [System Time...].

Install

File BLEEIN Mode

Befer Configuration...
System Tuning...
Legical Device Format..
Manual Dump...
MP Instali...
Syslem lime...
Set IP Address...
PCB Revision Display...

Define Configuration and Install...

Copyright ©1995,1996, Hitachi, Ltd.
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(5) Specify the date (year, month and day) and time
(hour, minute and second) and select (CL) [OK]. TOD change

(6) Close the ‘Install’ window.

Copyright ©1995, Hitachi, Ltd.
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10.2.2 Log indication

[1]1 SSB Log SVP02-40
[2] SIM Log SVP02-60
[3] Detail Log SVP02-70
[4] Reset Log SVP02-80
[5] Power Event Log SVP02-90
[6] Incident Log SVP02-100
[7JLCP/MCP Log SVP02-110
[8] Diag Log SVP02-120

Indication condition
If there is no corresponding log, you cannot select any log from the menu.

Do this first:
(1) Select (DC) the [Information] icon in the ‘SVP’ window. .

Fdcopy

Status

Install

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright (C) 1994,1995,Hitachi,Ltd.

(3) Select (CL) the [View] menu in the ‘Information’
window and select (DR) [Log]. File Mgde

418

Monitar

Emdreament Monitor...
Pinaed Track

Thweshold Velue Massger
Dnline Rewd Margin

MBI gy

Copyright ©1995, Hitachi, Ltd.

I REV.4 HMar.1995,Apr.1995|May.1995|Jun.1995|Oc(.1995'

|

SVP02-30




K6600890-

[1] SSB Log

(1) Select (CL) [SSB Log] in the ‘Log’ dialog box.

Select (CL) the [View] menu in the ‘Information’ Ele EdiView Qption 3
window and select (DR) [List...J [— - =

@®issBleg! E4asTl O incident Log fE3sT)

O SiMLen [cOMP] O LCPMMCP Log [>asT)

QO Detsit Log E©asT] O Disgtog [122)]

O Resetiog [BasT)

O Pewer Event Log {©asT)

(2) Select (CL) data to be indicated in the ‘SSB log’
dialog box and select (CL) [Content...]. : ]
Notel: To sort and list items, select (CL) [Sort...] first.
Then select (CL) the desired item in the [Item]
and [Order] options in the ‘SSB Log Sort’ dialog
box, and select (CL) [OK]. To search for the
desired log, select (CL) [Search...]. Then set the

1 which w indivi i
og for which you want to search individual List 558 Log Sarl

in the 'SSB Search Condition' dialog box and
M hem Dider

select (CL) [OK]. o ® Nomal

Note2: In case of the log data exceeded 1000 cases O Enoe Code O Revesze
. . O Micio Pr

(Denominator of the total displays 1000 or more), O Logical Device

the log data can be displayed from new data to O Action Code

1000 data out of the entry sequence on SVP. g:mt

The entry sequence sometimes differs from

occurrence order of the log.

Perform search function in order to check
occurrence order.

Please do not change an application’s window
until search function finish.

Copyright ©1995, Hitachi, Ltd.
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(3) The ‘SSB Log’ dialog box is displayed.
Select (CL) [Reference...] in the ‘SSB Log’ dialog box, when
the relative log is displayed.

e I
Date/Tine: 5725795 13:10:59
ACCINFC/ESC): 08 40 azeace .
ACCIFIC): S822 0008 0088 0008 9090 90000888
Error Code: 9001
Procesece: svr
IDEY:
PDEV(C/R):
) 2¢ § ec
3 7 B F

CTEL Duta: 80 S£BS1%0d 12 90008198 900

10 20800000 000094£0 [
Data: 20 000005ec 20819000

3n 0000f tac
Intexsal: 40 0! 017 20000000
SSB Data 50

[}

70

(4) Select (CL) the log to be displayed in the ‘Reference’ dialog box.
([SSB] is selected in this example.)

Detail Log:
SYTH Log:

SSB lLog: 1

(5) Display the log to be selected.
(‘SSB Log’ is displayed in this example.)
See SSB LOG Section

SSH Log
tos o.: 2
Date Tine: 1995705703 21:30:29
ACC{XPC/ESC]: 08 10 — 1
ACCIFPC): 6021 0800 8080 D000 COOD 2150000
Error Code: 1508
Processor : DXPS-1G
IDEV: [ 1]
F/u: L 1]
7 B ¥
CTEL Data: o¢ S£08503: leldo18f 15 00a21cbd
10 S0000004&
SSB Data: 20 008010ff 4000008f 15002e77 a7210560
s 8004££8¢1 00004 00000000
Intexnal: 48 4000fcec 26 thbletsé
SSB Data 50 73756d43 48
g: 00000000

(6) Select (CL) [Close] in the ‘SSB Log’ dialog box.
Select (CL) [OK] in the 'SSB Log' dialog box.
Close the ‘Log’ dialog box and close the ‘Information’

window.

Copyright ©1995, Hitachi, Ltd.
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[2] SIM Log

Note: When SIM log exists after SVP started up, the ‘SIM Message’ window is displayed.

(1) Select (CL) [SIM Log] in the ‘Log’ dialog box.
Select (CL) the {View] menu in the ‘Information’

window and select (DR) [List...].

Ellc  Edit Yiew QOption

=] Log BE
O $5B Log [EaST] O incident Lon feasT
@iSMLod [COMP] O LCPMCP Log [BasTm
O Detsil Log [©asT] O Disg Log [EXsT)
O Reset Log masn

O Power Event Log BasT

(2) Select (CL) data to be indicated in the ‘SIM log’

dialog box and select (CL) [Content...].

Note: To sort and list items, select (CL) [Sort] first.
Then select (CL) the desired item in the [Item])
and [Order] options in the ‘SIM Log Sort’ dialog

box, and select (CL) [OK].

Total: 20

Date/Time Refetence Code  Level
475795 13 31 02

47 5795 04210 biS080

47 4795 15:14:27 bf5120 |

474795 15:14:26 bi5020 1:Modesate
47 4/3515:14:26 bi4120 B

4/ 4735 15:14:25 bi5110

47 4795 1514:25 biS010

Item

@ Date/Time:

‘O Entor Level

-

(3) The ‘SIM Log’ dialog box is displayed.

Select (CL) [Reference...] in the ‘SIM Log’ dialog box,

when the relative log is displayed.

DateTise: 522095 23:56-04
Alert Lavel: Moderate
Eefersace Code: bi3%871

SIN Data: 20 00’010!: OGIDII.; nuauos le?llﬂﬂ:
R 30 75340000 0000L{%0 5100000 f1000000
Notel: In WCHK1 dump and ABEND dump received SIM Status: Initial

(RC = 3080X0, 3081X0), the system error code is

AcC: KFC ESC FPC ADD

a8 40 CBOS 8800 0080 GOOO 00CO 6000080
Failure Descriptiom:
ENVIROFNENT CEECK (DEC)

indicated in the format [YYYY] as in Reference Code [rimm:

3080X0[YYYY].

Note2: If Reference Code is 73XX00 or 1400X0, perform the
recovery procedure for LAN error. (see TRBL05-70.)

rec Possible Failure parts Locatiom
CBOS DXWNME PCB ( ) DXUNE-R1R

Copyright ©1995, Hitachi, Ltd.
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(4) Select (CL) the log to be displayed in the ‘Reference’ dialog box.

(558 is seected i s cxample

Detail Log:

51X Lag:

SSB log: 61675
—
(5) Display the log to be selected.
(‘SSB Log’ is displayed in this example.) s
log h:: ) G::T‘ S R
:lmt:ﬂx-. 17 l:as 3:31:82 _ - -
ACC(FPC): 6011 0000 0000 0886 0000 0000006

Exror Code: 0088
PFrocassor : svr

3 ? F
CTHL Data: 80 SEP40SBd 1£020100
10 Gabt @

SSB Data: 20 10000000 $000018c 00008 080000R0
Intaraal : 40 444b4320 44502000 6636
Data 50

0

70

(6) Select (CL) [Close] in the ‘SSB Log’ dialog box.
Select (CL) [Close] in the ‘SIM Log’ dialog box.
Select (CL) [OK] in the ‘SIM Log’ dialog box.

Close the ‘Log’ dialog box and close the ‘Information’
‘window.

Copyright ©1995, Hitachi, Lid.
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[3] Detail Log

(1) Select (CL) [Detail Log] in the ‘Log’ dialog box.
Select (CL) the [View] menu in the ‘Information’
window and select (DR) [List].

_ Mv‘
Ble_Edt_Yiew_Qpion E—

O 'ssBLog [Easn O incident Log [easm
OsMisg ICOMP] O LCPMCP Log sy
@Detail Log. [EXST]  ODisqg Loa [easT
O Reset Log [EXasT)

Q Power Event Log [easm

(2) Select (CL) data to be indicated in the ‘Detail Log’
dialog box and select (CL) [Content...].

Note: To sort and list items, select (CL) [Sort] first.
Then select (CL) the desired item in the [Item]
and [Order] options in the ‘Detail Log Sort’
dialog box, and select (CL) [OK].

Total: 6

Date/Time Code
02/04795 08:07:00
02/04795 08:05:20
02/04/95 08:03:47
02/04/95 08:01:58

02/04/95 08:00:12
02/04/35 07:58:29

wwoooliy

' Detail Log Sort I

Item ™ Order

@ Date/Tane: @ Nomal
QO Enor Code Q Reverse

QO Micro Processor

(3) The ‘Detail Log’ dialog box is displayed.

‘_—_—_—W—__——!

Date/Time: 1994-10-29 13:39:27 -
Error Code:  32f4 Lloeei
FProcessor :

Detail Data:

0030 D0Ec7E0D
0040 00007000 ££0£3801 ac3%4e00 90a03000

(4) Select (CL) [Close] in the ‘Detail Log’ dialog box.
Select (CL) [OK] in the ‘Detail Log’ dialog box.
Close the ‘Log’ dialog box and close the ‘Information’
window.

Copyright ©1995, Hitachi, Lid.

| Revi4 | Mar.105 | apr.1905 [ apr.1905  sun.199] Oct.1995 | ] SVP02-70




K6600890-

[4] Reset Log

(1) Select (CL) [Reset Log] in the ‘Log’ dialog box. ' -
Select (CL) the [View] menu in the ‘Information’

window and select (DR) [List]. Lag ey

OssBLog BAST] O incident Log [Basn
QO SiMLog [COMP} O LCPMCP Log [exasT)
O Detsll Log [E4ST] O Disg Log 2asT)
@Resetlog! Basm

O Power Event Log [easT}

(2) Select (CL) data to be indicated in the ‘Reset Log’

dialog box and select (CL) [Content...]. Reset Log
Note: To sort and list items, select (CL) [Sort] first. Total: 32
Then select (CL) the desired item in the [Item)] Date/Time Type

01/18/95 02:01:33
01/18/95 02:01:32
01/18/95 02:01:31
01718795 02:01:31
01718795 02:01:31
01/18795 02:01:30
01/18/95 02:01:30

and [Order] options in the ‘Reset Log Sort’
dialog box, and select (CL) [OK].

casmcaltlp

[T T—

Item Ordes

@ Date/Time! @® Normal
O Micro Processor O Reverse
O Type

(3) The ‘Reset Log’ dialog box is displayed.

Date/Tias: 2/23/95 10:45:24 Closei

Proceswsor: CHPO-1E

Resot Data: [g9pp 5102170a 2d185245 00030700 00cc00£0 |t

0016 02000004 10000000 00000000 GOO00DOQ
0020 58011000 00000000 02020000 00000000
0830 00000000 07000000 00200000 00080000
0040 «0073c00 00000000 00000000 00000000
00S0 60000000 a8Scat0? 4cSdafl2 755dafd2
0060 efb6af02 4(7b7a£02 26160801 00000700
0070 00000000 00000000 202e2000 00000000 |3

(4) Select (CL) [Close] in the ‘Reset Log’ dialog box.
Select (CL) [OK] in the ‘Reset Log’ dialog box.
Close the ‘Log’ dialog box and close the ‘Information’
window.

Copyright ©1995, Hitachi, Ltd.
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[5] Power Event Log

(1) Select (CL) [Power Event Log] in the ‘Log’ dialog box.
Select (CL) the [View] menu in the ‘Information’

T‘:“ﬁ 2
File Edit View Iinn

. . - Log f=1+
window and select (DR) [List]. 5oL ST O tmasentiog s
a e !
O siM Log ICOMPL O LCPMMCP Log B3asT)
O Detsil Log [EXIST] O Diag Log [EXIST)
O Resetlog [2asT)
@ Bywer Eventlon [EXST}

(2) The ‘Power Event Log’ dialog box is displayed.

Note: To sort and list items, select (CL) [Sort] first.

Power Event Log

Then select (CL) the desired item in the [Item) Tl 2%
i i ‘P E Lo, Di‘e 3643 os Tm
10/.2/95 12 36 4 1 SYSTEM ON
and [O‘rder] options in the ‘Power Event Log s ] SYSTEWON
Sort’ dialog box, and select (CL) [OK]. Ly B SSTEMON
107 2/95 12-36:48 c SYSTEM ON
10/ 2/95 12:36:47 8 SYSTEM ON
9/29/35 20:32:29 1 SYSTEM ON
I Power Event Log Sort l
ltem Ordes
@ Date/Time! @ Nomal
O Micro Processor QO Reverse
O 1spe

(3) Select (CL) [OK] in the ‘Power Event Log’ dialog box.
Close the ‘Log’ dialog box and close the ‘Information’

window.

Copyright ©1995, Hitachi, Ltd.
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[6] Incident Log

(1) Select (CL) [Incident Log] in the ‘Log’ dialog box.
Select (CL) the [View] menu in the ‘Information’

Infarmation

window and select @R) [List]. Ossaten O — asn
QO $IM Log [COMP] O LCPMCP Log [EXIST)
QO Detall Log fBasT} O Disg Log feasn
O ResetLog [EasT]
O Power Event Log [DasT}

(2) Select (CL) data to be indicated in the ‘Incident Log’
dialog box and select (CL) [Content...].
Note: To sort and list items, select (CL) [Sort] first. Total: 2

Then select (CL) the desired item in the [Item]
and [Order] options in the ‘Incident Log Sort’
dialog box, and select (CL) [OK].

[T —

Item Dides

@ iDate/Time:! @ Nomal
O Reference Code O Reverse
O Micso Processor

O LcP/MCP

(3) The ‘Incident Log’ dialog box is displayed.

Date/Tinme:
Error Cods:
Processor:
ICP/NCP:

Incident Data:

Incident Log

8/25/95 14:31:58

7a89

CHP2-1F

16

3 7
5£08190e 1£3a0301
060000c0 00000000
f0£0£5¢2 £D0c9c2dd
f0£B£1

el

B F
0280897a 4a000000
00000137 £0£0£9£0
£9£7£0£0 £0£0£0£0
£3 £1£20037 £EEEFEEF SELEEEES
£ £EE60001 SCEEEEEE EEEEEEES
£f fE£E£££¢f 00000000 000OQODOC

(4) Select (CL) [Close] in the ‘Incident Log’ dialog box.
Select (CL) [OK] in the ‘Incident Log’ dialog box.
Close the ‘Log’ dialog box and close the ‘Information’
window,

Copyright ©1995, Hitachi, Ltd.
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[7) LCP/MCP Log

(1) Select (CL) [LCP Log] in the ‘Log’ dialog box.
Select (CL) the [View] menu in the ‘Information’
window and select (DR) [List].

.EH: Edit Yiew QOption

=l

O 558 1og
OsivLeg

O Detali Log

O ResetLog

O Power Event Log

bl
Lag Erin]
B4AST] O ncideat Log L2
[COMPT  ©CPMCP Lag' [exsT]
©asT) O Disglop [easm
easn
easT)

(2) Select (CL) data to be indicated in the ‘LCP/MCP Log’
dialog box and select (CL) [Content...].

Note: To sort and list items, select (CL) [Sort] first.
Then select (CL) the desired item in the [Item]
and [Order] options in the ‘LCP Log Sort’ dialog
box, and select (CL) [QK].

LCP/MCP Log ==

Total: 1
Data/Time

9/28795 20 AG 47

12050004

SEQ  LCPMCP
0000 A

I LCP/MCP Log Sort '

Item Ordes
@ Date/Time! @ Nomal
O Enor Code O Reverse
O sEa

O LcPmMcP

(3) The ‘LCP/MCP Log’ dialog box is displayed.

Dates/Tine:
Error Code:
SEQ:

LCP/NCP:
LCP/MCP Data:

CHP Data:

1995/05/30 19:20:48

LCPIMCP Log

£1020003

gooo
1A

00000715 00000710 2fcatiSbh 00000000
£1020003 £1020000 08040000 06000000

00000000 00080003 0el20df0 bL0002138

66016500 00006729

3 00000000 70a67008

A&

400 ODcBOD:

000070cc £8020000

oooé

lec

LR 20

(4) Select (CL) [Close] in the ‘LCP/MCP Log’ dialog box.
Select (CL) [OK] in the ‘LCP/MCP Log’ dialog box.
Close the ‘Log’ dialog box and close the ‘Information’
window.

Copyright ©1995,1996, Hitachi, Ltd.
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[8] Diag Log

(1) Select (CL) [Diag Log] in the ‘Log’ dialog box.

Select (CL) the [View] menu in the ‘Information’ T I T S ———
T

. . - Log -
window and select (DR) [List]. O 555 Log PO O mtem g s
O SIM Log fCOMP] O LCPMCP Log {EXIST)
O Detsil Log [B4ST]  @Disaled [E4sT)
O Reset Log [BasT)

O Powet Event Log fEXST)

(2) Select (CL) data to be indicated in the ‘Diag Log’
dialog box and select (CL) [Content...]. —
Note: To sort and list items, select (CL) [Sort] first.

Then select (CL) the desired item in the [Item]
and [Order] options in the ‘Diag Log Sort’ dialog
box, and select (CL) [OK].

Date/Tme Typo MP Tt Coda

[T —]

[~ item Order
@ iDate/ ] me: @ Nomal
QO Iype O Revesse
O Micto P
QO Test Number
O Eno Code

(3) The ‘Diag Log’ dialog box is displayed.

- — —
Diag Log

DatesTine: 4/ 5795 14:50:21

ACCI[NFC/ESC]: 01 00

ACC(FPC): 0001 0000 0000 000C 0000 90CO0OOD
Processor: CNPO-1E

Object :

CUDG Type:

Tost Number: 0
Error Code: 0000
PCB Location:

Dotail: 00000000 00000000 00000000 00000000
Inforaation 00000000 00030000 00000000 00600000

(4) Select (CL) [Close] in the ‘Diag Log’ dialog box.
Select (CL) [OK] in the ‘Diag Log’ dialog box.
Close the ‘Log’ dialog box and close the ‘Information’
window.

Copyright ©1995, Hitachi, Ltd.
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10.2.3 Log delete

[11SSB Log

[2] SIM Log

[3] Detail Log

[4] Reset Log

[S] Power Event Log
[6] Incident Log
[71LCP/MCP Log
[8] Diag Log

(1) Select (DC) the [Information] icon in the ‘SVP’ window.

Intarmation

Fdcopy

Status

Install

Online

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright [C) 1994,1995,Hitachi,Ltd.

(3) Select (CL) the [Mode] menu in the ‘Information’

window and select (DR) [Modify].

.\"E.llc View QYO

Information

Copyright ©1995, Hitachi, Ltd.
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(4) Select (CL) the [View] menu in the ‘Information’
window and select (DR) [Log]. Fie ugde

N f

Errvironment bisaitol..
Pianed Track_.

Ihreabold Volue Maasger  #
Qnline Resd Margin W

Maininancs Hiclon,

(5) Inthe Log dialog box, select (CL) an item to be deleted.

Select (CL) the [Edit] menu in the ‘Information’
window and select (DR) [Delete]. i Log :
QO SSB Log EXST] O incident Log feasTn
@iSiM Lo ICOMP] O LCPMCP Log [EXsT)
O Detall Log Bast] O Diag Log ©dasT
O ResetlLog [E4asT)

O Power Event Log [EXIST)

(6) Select (CL) [OK] in the ‘Log Delete’ dialog box.
Log Delete

The SIM log file will be deleted.

(7) Close the ‘Log’ dialog box and close the
‘Information” window.

Copyright ©1995,1996, Hitachi, Ltd.
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10.2.4 Monitoring
[1] Displaying a graph for items SVP02-160
[2] Displaying the operation ratio of the processor SVP02-180
[3] Displaying the use ratio of the cache and the write pending data ratio in a tabular form ———————— SVP02-200
[4] Displaying the read hit ratio in a tabular form SVP02-201
[5] Displaying the use ratio of the BUS in a tabular form SVP02-202

(1) Select (DC) the [Information] icon in the ‘SVP’ window.

ﬁ

Sus  Diag

Fdcopy Instalt Online

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright [C] 1994,1995,Hitachi,Ltd.

OK

(3) Select (CL) the [View] menu in the ‘Information’ window

and select (DR) [Monitor]. W

Leg
[Emvironment Monitor.—.
Binocd Track

Teroehold Valuc Monager  »
Dnline Read Mergin ¥

Maintnance [{istory...

Copyright ©1995,1996,1997, Hitachi, Ltd.
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[1] Displaying a graph for items

(1) Select (CL) the [Monitor] menu in the ‘Information’
window and select (DR) [Start...].

Intormation

Flie BEIGUNTE Detall

Muirtlur

(2) Select (CL) [Interval] , {File Output] , and [Item] in the

‘Monitoring’ dialog box and select (CL) [OK].

Note 1: When you select [Processor Operation] in the “Item” Interval
list box, “Interval” indicates a time interval from 5 to & £Re Output
3600 at which samples are taken. —‘E" v D] Broad et Ratio
When you do not select [Processor Operation] in the [ Sidefie O Read Hit Rate
“Item” list box, “Interval” indicates a time interval [ Brocessor Operation [ Soquontial Read Hit Rate
from 5 to 43200 at which samples are taken. Si:.r P g::::

Note 2: Up to three items can be selected in the “Item” list
box. The selectable values are: R ————
Processor Operation : Operation ratio of the processor
Write Pending Data : Write pending data ratio
Cache Used : Use ratio of the cache
Read Hit Rate : Read hit ratio of the subsystem
Sidefile : Sidefile ratio of the subsystem

After SVP version is 01-06-28/00 or 01-07-02/00

MBUS : Use ratio of MBUS

FBUS : Use ratio of FBUS

(3) After a few minutes, a graph is displayed for the
item selected in step (2). e -

By

— Processse Oparviien 115 === Wi Peadmy Date 006
— Cache Used %

IM/\QA/\M N\ﬂ'\/\f\[\h"-/\

Copyright ©1995,1996,1997, Hitachi, Ltd.
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(4) Select (CL) the [Monitor] menu in the ‘Information’
window and select (DR) [End].

Manilor

(5) When the message “DKC Monitor will be terminated”
is displayed in the ‘Monitoring’ dialog box, select(CL)
[Yes].

Monitoring

0 DKC Monitor will be terminated.

(6) Close the ‘Monitor’ dialog box and close the ‘Information’
window.

Copyright ©1995, Hitachi, Ltd.
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[2] Displaying the operation ratio of the processor

(1) Display a graph (see steps listed above).
Select (CL) [Processor Operation] in the “Item” list box.
Select (CL) the [Detail} menu in the ‘Information’
window, and select (DR) [Processor].

Infarmation

Mﬂle MoniHor BsI3PH]

Maonitor

(2) Select (CL) [Part...Jin the ‘Processor’ dialog box.

(3) Select (DR) the contents of “Parts” in the ‘Parts’
dialog box and select (CL) [OK].
Note: In the Parts list box, the following values are
selectable. Pasts :
[SystemAvercse |3

System Average : Average in the system
CHP Average  : Average for the CHP
DKP Average  : Average for the DKP

CHPO-1E : Average for a particular processor
CHP1-1E : Average for a particular processor’
CHP2-1F : Average for a particular processor
CHP3-1F : Average for a particular processor
CHP4-2Q : Average for a particular processor
CHP5-2Q : Average for a particular processor
CHP6-2R : Average for a particular processor
CHP7-2R : Average for a particular processor
DKP8-1G : Average for a particular processor
DKP9-1H : Average for a particular processor
DKPA-1J : Average for a particular processor
DKPB-1K : Average for a particular processor
DKPC-2L : Average for a particular processor
DKPD-2M : Average for a particular processor
DKPE-2N : Average for a particular processor
DKPF-2P : Average for a particular processor

Copyright ©1995,1996, Hitachi, Ltd.
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(4) Select (CL) [OK] in the ‘Processor’ dialog box.

(5) Close the ‘Monitor’ dialog box and close the ‘Information’
window.

Copyright ©1995, Hitachi, Ltd.
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[3] Displaying the use ratio of the cache and the write pending data ratio in a tabular form.

(1) Display a graph (see section [1] (SVP02-160) above).

Select (CL) [Write Pending Data], [Cache Used] or Ellc YT et Information

[Sidefile] in the “Item” list box. Select (CL) [Detail] in  F- TN - OO0
CESS0r...

the ‘Information’ window, and select (DR) [Cache]. Interval : Dsec| paw..,

(2) Select (CL) [OK] in the “‘Cache’ dialog box.

Available Capacity : 256MB
Date/Tame
1710796 17:14:38

110/36 17:14:33
1/710/96 17:14:28

110/96 17:14:23
1710796 17:14:17
110736 17:14:12
1710796 17:14:07
1/10/36 17:14:01

B“ﬂﬂﬂg.ﬂ?ﬂ\
WONO~N~ #

~

(3) Close the “Monitor’ dialog box and close the ‘Information’
window.

Copyright ©1995,1996, Hitachi, Ltd.
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[4] Displaying the read hit ratio in a tabular form

(1) Display a graph by executing steps (1) to (5) in
*“[1] Displaying a graph for items” in advance.
In step (2), select (CL) [Read Hit Rate] in the “Item” list
box. Select (CL) [Detail] in the ‘Information’ window,
and select (DR) [R/W...].

o)
File Monitor B3R
= Monitor

Information

(2) Select (CL) [OK] in the ‘R/'W’ dialog box.

> 67.9
12712795 19:38:27 9.7
1212795 19:38:22 99.2
1212795 19:38:17 84.7
1212/85 19:38:12 91.8
12712795 19:38:07 97.8
12712795 19:38:02 55.0

(3) Close the ‘Monitor’ window and close the ‘Information’
window.

Copyright ©1996, Hitachi, Ltd.
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[5] Displaying the use ratio of the BUS in a tabular form (After SVP version is 01-06-28/00 or 01-07-02/00)

(1) Display a graph by executing steps (1) to (5) in
“[1] Displaying a graph for items” in advance. ! Information
Select (CL) [Detail] in the ‘Information’ window, File Monitor gelZC
and select (DR) [BUS...].

(2) Select (CL) [OK] in the ‘BUS’ dialog box.

Date/Time MBUS FBUS

197/02/17 16:54:10 6 10 +
1997/02/17 16:54:00 ] 10
1997/02/17 16:53:50 6 10
1997/02/17 16:53:40 6 10
1997702717 16:53:30 6 10
1997702/17 16:53:20 6 10
1987/0217 16:53:10 6 1
1837/02/17 16:52:59 6 1n 3

(3) Close the ‘Monitor’ window and close the ‘Information’

K6600890-
|
|
|

window. |
|
|
|

Copyright ©1997, Hitachi, Ltd.
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10.2.5 Environment Monitor

(1) Select (DC) the [Information] icon in the ‘SVP’ window.

Fdcopy Install Online

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright [C) 1994,1995,Hitachi,Ltd.

(3) -Select (CL) the [View] menu in the ‘Information’
window and select (DR) [Environment Monitor...].

Inlarmation

| nvironnient Monitor..

Pinned Track..

Ihreshold Value Manager &
Qnline Resd Msrgin *

Mnintnanes diviany...

(4) Select (CL) the corresponding item in the

‘Environment Monitor’ dialog box and select (CL) [Detail]. ,
I'Putt
© Themal [ ALARM |
O Vokage [ ALARM )
Cers [ WARNING }
O Battery [ WARNING ]
Oac 1 WARNING |
O Fan [ WARNING ]

Copyright ©1985, Hitachi, Ltd.
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(5) Details of the item selected in Step (4) is displayed

(“Thermal” is selected in this example). Thermal

DKC Logic-1 ALARM
Logic-2 ALARM

(6) Select (CL) [OK] in the ‘Thermal’ dialog box.

(7) Close the ‘Environment Monitor’ dialog box and close the
‘Information’ window.

Copyright ©1995, Hitachi, Ltd.
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10.2.6 Online read margin (ORM)
[Overview]
The on-line read margin test (ORM) function is a read diagnostic function provided for preventive maintenance of disk

drives. The diagnostic is automatically executed in each SCSI drive. The DKC reads the diagnostic result at
specified intervals and reports it to the SVP.

SVP DKC DKU
|
IAnaIyze the diagnosis result. {é
Read the result of ORM Execute ORM diagnosis
diagnosis at specified é_ (read diagnosis) at
intervals. | specified intervals.
lUpdaie the threshold counter. J
Create ORM log. mg‘gedgggﬁs Log the diagnosis result.
Check whether the threshold Interval: 8 hours per DKU Interval: Once every 12 seconds
is exceeded. Applicable DKUs: Condition for execute:
: Data disk ?togé)ocorms fromthe DKC
. > or 3
. The threshold Spare disk Dieu;.;m::asirsr:Is
« is exceeded. Read diagnosis is executed
- for each cylinder.
When I/0 comes from the DKC
. during diagnosis, the read
[Create alarm SIM. diagnosis is suspended immediately
after diagnosis of the current

sector is completed,

The SVP calculates the error ratio to the threshold value which is set in advance, and indicates it in the OVER RATE
Display (see [1], (2)). When the Rate in the display exceeds 100%, it means the error count is exceeding the threshold,
the SVP creates the warning SIM. It is, however, not reported to the Host.  The disk drive reporting the SIM should
be exchanged with higher priority than other normal drives.

The SVP classifies the errors into six types in the Over Rate Counter Display. They are Unrecovered Read Error,
Recovered Read Error, Unrecovered Seek error, Recovered Seek Error, Not Ready and Other Errors. Each has three
types of counters indicated as Today, 7 days and Total. Refer to [1], (4) for the Over Rate Counter Display. Inthe
OVER RATE Display, the error ratio which has the largest number among those classified types is displayed for each
drive to represent each error.

The warning SIMs to be reported in the ORM are shown below.

ORM SIM and Reference Code

No Error Type Reference Code Meaning
1 | Unrecovered Read Error 5020 Drive Media Error
2 | Recovered Read Error
3 | Unrecovered Seek Error 5010 Drive Unit Error
4 | Recovered Seek Error
5 | Not Ready
6 | Other Errors

Copyright ©1995, Hitachi, Ltd.
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{1] Displaying an error count, thresholds, and Iog SVP02-250
[2] Resetting an error count SVP02-280
[3] Displaying thresholds SVP02-300
[4] Altering a threshold SVP02-310
[5] Displaying the ORM running status SVP02-330
[6] Resetting thresholds SVP02-335

(1) Select (DC) the [Information] icon in the ‘SVP’ window.

=

=

Status

Install

Diag

Online

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright [C) 1994,1995,Hitachi,Ltd.

OK

Copyright ©1995,1996, Hitachi, Ltd.
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(1] Displaying an error count, thresholds, and log

(1) Select (CL) the [View] menu in the ‘Information’
window and select (DR) [Online Read Margin).
A pop-up menu will appear. Select (DR) [Over Rate
Display].

Moattor

Ewvironmant Monter_.
Binned Track..

Threahold Velue Manager ¥

Parity Emor.. Threshold Value A/D
| Msirtenance History... Bunning s.?h”

id Valoe

(2) Enter a value from 0 to 100 at “Rate” in the ‘ORM Over
Rate HDD# Display’ dialog box. Select (CL) [Display].
Then only the HDDs which have.the rate of equal to or
greater than the specified value will appear in the display.

— e
| ORM Over Rate HDD? Display i

HDD Location Rate  Rote
R100{DK306-45] 160.0 +
PR=s &
RII7DK30645] 0810

315

i

(3) When more detail information is needed for the particular drive,

select (CL) the HDD from the “HDD Location” list box.

i ORM Over Rate HDD?# Display

Select (CL) [Detail]. ﬂu
B
R117[DK306-45) 6810
3] | Sose l
Copyright ©1995,1996, Hitachi, Ltd.
SVP02-250
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(4) Inthe ‘Over Rate Counter Display’ dialog box,
select (CL) the error for which detailed log is to be displayed from the “ID” list box. Select (CL) [ORM LOG].

Over Rate Counter Display

HDD Location:R107(DK306-45)

ID[{Information Toda 7 days

Head Ermror [Uniecovered guuouoD4/5 yuuuoouy.z- vouuuLLL /-
Read Error {(Recovered) 4.13e-011{Ecror/bit}{00000001 /2.422270e+010)
Seek Emor (Recovered) 000000007100 00000000/300 00000000/-
Seek Emor [Unrecovered) 00000000410 00000000/30 00000000/-
Not Ready 0000000010 00000000/30 00000000/-
Other Enrors 00000003710 00000003730 00000233/-

[ Error Count / Threshold Value ]

The errors detected in the ORM are classified into six types of error category. Each error has the following
definition.
a) Read Error [Unrecovered]
A disk media error was detected. After ten times retries, the error was judged that it might become a serious
media error which could not be recovered with ECC or retries.
b) Read Error [Recovered]
A disk media error was detected. After ten times retries, the error was judged that it was an intermittent read
error and recoverable, and included in the error rate management for the preventive maintenance.
c) Seek Error [Recovered]
A seek error was detected. After ten times retries, the error was judged to be recoverable.
d) Seek Error [Unrecovered]
A seek error was detected. After ten times retries, the error was judged to be unrecoverable.
e) Not Ready
Not Ready status of the drive was detected.
f) Other Errors
Any error which does not belong to the above classification was detected.

They are also managed with different time periods. “Today” is for one day count and cleared at AM 0:00 every day.
“7 days” is for the curulative value in the latest 7 days. “Total” shows the total cumulative count.

In this Over Rate Counter Display, each error category indicates the Error Count and the Threshold value except for
the Read Error [Recovered]. The “-” for the Threshold value means no threshold is set.

Only the Read Error [Recovered] has an error rate expression. It is not managed with error count per day, per 7 days
or Total. The error rate of the Read Error [Recovered] is calculated in the following formula:

Error rate = Number of error sectors/Number of ORM scan bits

Note 1)  Only the result from approximately the latest one volume scan in ORM is used for the
calculation.

Copyright ©1995,1996,1997, Hitachi, Ltd.
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In the example display, “4.13e-011” means the error rate is “3.18 x 10"%. This is corresponding to the raw error
count and scan bits shown as “00000001/2.422270e+010”, where the error count is one sector and the scan bits is
2.422270 x 10"°.

(5) The nature of the error selected in step (4) is displayed.

(In this example, the nature of “Other Errors” is ’ : O Leg Display ]'
Log Information Log Ordes
‘ HDD Location:R107[DK30645)
displayed.) Tl?lu:'-nﬂ 1D:05. S’u".i. Errors {@ Iime -I
Total Log Husber: 233 O LBA

ORM Log Data

{o000 E7Azcc2£suzas4m1z:ussnmunuum[| Cose |
—

Byte Bit Name Explanation
0-3 UCT Time when the diagnostic result was reported from the DKC to the SVP
4 7 " Log Valid When this bit is 1, it indicates that this log is valid.
6 Address Valid | When this bit is 1, it indicates that the address information in bytes 8 to F is
valid

5-4 (Reserved) | Reserved
3-0 Sense Key | Error sense key in the SCSI drive report. (*1)

5 Additional Additional sense code in the SCSI drive report .(*1)
Sense
Code
6 Sense Code | Additional sense code qualifier in the SCSI drive report. (*1)
Qualifier
7 Seek Error | Number of seek errors within 10 seck error retries.
Count
8-9 CC Address of the cylinder where the error occurred.
A H Address of the head where the error occurred.
B S Address of the sector where the error occurred.
C-F LBA LBA where the error occurred.

*1 Definition and contents of the error codes are same as those of the SSB for ordinary DKU errors.

(6) Select (CL) [Close] in the ‘ORM Log Display’ dialog box.
(7) Select (CL) [Close] in the ‘Over Rate Counter Display’ dialog box.
(8) Select (CL) [Close] in the ‘ORM Over Rate HDD# Display’ dialog box.

(9) Close the ‘Information’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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[2] Resetting an error count

(1) Select (CL) the [Mode] menu in the ‘Information’
window and select (DR) [Modify]. e View

View

(2) Select (CL) the [View] menu in the ‘Information’
window and select (DR) [Online Read Margin].
A pop-up menu will-appear. Select (DR) [Over Rate
Display].

Binned Track...
Threshold Velue Mansger  »

Pyrity Error. Threshold Value AJD
[_Msimensnce History... Bunnieg Strkie. TS
(3) Enter a value from 0 to 100 at ‘Rate’ in the ‘ORM Over
Rate HDD# Display’ dialog box. Select (CL) [Display]. ORM OverRate HODZ Display '
HDD Location Fate B

IFI'III}[DKBW—J!FI 160.0 |+

(4) Inthe ‘ORM Over Rate HDD# Display’ dialog box, select (CL)

’ : ver Rate % Displa: i
the HDD for which an error count and thresholds are to be QRMIOVFURAEHOD iz l2y ‘
displayed from the “HDD Location™ list box. Select (CL) [Detail].

Copyright ©1995,1996, Hitachi, Ltd.
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(5) Inthe ‘Over Rate Counter Display’ dialog box,
select (CL) [Reset].

Ovcr Nate Counter Display

Total
DO000004/S 00000000/ -
4,132-011[Ermoe/bt §OON000CT /2 422270+ 010)
00000000100 DOCOODON/300 -
Snﬂé Eroe [Ureecovesed]  00D000O0/10  0O0DOOOO/30  0ODOOOOD/-

Mot Roeadsy 00000000/10  DOGDOCOO/30 00000000/
Other Emors 00000003/10  DODDOOOS/30  DOOGO2IY/-

[ Emor Count 7 Threshold Value |

(6) Select (CL) {OK] in the ‘Threshold Counter Reset’
dialog box.

Threshold Counter Reset

Are you sure you want to reset Threshold
Counter of all ID?

I 0K | Cancel

(7) Select (CL) [Close] in the ‘Over Rate Counter Display’ dialog box.

(8) Select (CL) [Close] in the ‘ORM Over Rate HDD# Display’ dialog box.

(9) Close the ‘Information’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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(1) Select (CL) the [View] menu in the ‘Information’
window and select (DR) [Online Read Margin].

A pop-up menu will appear. Select (DR) [Threshold
Value A/D].

Emvironment Monltor...
Binoed Trock..
Threshold Velue Monsger 3

[intine Head Margin
Parity Emor— Thiversbanlil Yatue ATy
| Maintenance Hizmory.. | .B‘:_'I'nPD i‘“‘"

Dver Asts Dicpley

Value

(2) Inthe ‘ORM Threshold Alter/Display’ dialog box, select _ _
(CL) an HDD from the “HDD#” list box and select (CL) e

HDD® T Valum

[Display]. In order to display threshold of another . HDD Locaterc 100
interval, select (CL) the interval from the “Type” list |@'~$-r O7dim Oton I — —
bOX A 11 16 4% 000 Read Emr.[Urwecovered) D
’ 001 Read Er.[Recoversd]
Note: Multiple HDDs can be selected (CL) from the 002 Seek En.fRocoversd)
<« 5 1: . . . E306-45 003 Sesk En.{Uszscovarsd]
HDD#” list box while the control key is being RIAMDERC 43 004 Hot Ready

held down. In this case, each “Threshold” field Selocted HDD[2}1 005 Other Enore Gosn |

in the “Threshold Value” list box shows the
threshold for the HDD that is highlighted in the

“HDD#” list box.
crﬁ;t—‘rlll."lhl'“_ﬂiizl‘;ﬁnplqv
[HOO® I Tiweshold Ve
HDD Locatior:R100
Irpe
T T
@ Teday O7dage O Tod 0 gelemmaion) .
RANmOE TR A%
s 0 Sttt £
1
Rionc0 o 001 Read En.(Recoveed)
TEESIE 0 A%
n:.-s.‘:m. I 4-;{ 002 Seck Esr.(Recoversd)
O3 Seak . frescorwed
i e vt
e 00 odbienbinicd (5]

K6600880-
[3] Displaying thresholds
|

(3) Select (CL) [Close] in the ‘ORM Threshold Alter/Display’
dialog box and close the ‘Information’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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[4] Altering a threshold

(1) Select (CL) the [Mode] menu in the ‘Information’ window
and select (DR) [Modify]. TFile Yiow

Yiew

(2) Select (CL) the [View] menu in the ‘Information’ window
and select (DR) [Online Read Margin]. A pop-up menu
will appear. Select (DR) [Threshold Value A/D].

Ewviranment Monbor...
Binncd Track...
Threahold Value Menager  »

Uinkns Heard Margin

Qver Rate Dicpley
Parity Ermor... T bkl Yalue AT0

| Msimenance History... Bunning Status

(3) In the ‘ORM Threshold Alter/Display’ dialog box,
select (CL) an HDD from the “HDD#” list box and

OIM Tlreshold AliceDionlay

nove ~Th Vb
select (CL) [Display]. In order to display threshold of - (2w ] || 400 Locasorcnron
another interval, select (CL) the interval from the @ D (niermation) —
e B H LU g 000 Read Er.[rsecevered) |:]
Type” list box. 001 Raed Er faceveredh
002 Swek Ex.fRecovered)
003 Sesk Ex.[Unteceversd)
004 Net Ready
805 Other Emrors [(Gee |

(4) Inthe ‘ORM Threshold Alter/Display’ dialog box, alter _
the threshold in the “Threshold” field in the T R——

HOD® rTh d Ve

“Threshold Value” list box. Then select (CL) [Alter]. (o]
Note: When muitiple HDDs are selected in the Threshold
« * ki X
HDD#” list box, the thresholds of all HDDs ==
are altered to the same value,
C—

Dees |

Copyright ©1995,1996, Hitachi, Ltd.
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(5) Select (CL) [OK] in the “Alter Threshold Value’

dialog box.

Alter Thresheld Value

Are you sure you want te alter the threshold
value of the HDD you selected ?

(6) Select (CL) [Close] in the ‘ORM Threshold Alter/Display’
dialog box and close the ‘Information” window.

Copyright ©1995, Hitachi, Ltd.
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[5] Displaying the ORM running status

(1) Select (CL) the [View] menu in the ‘Information’
window and select (DR) [Online Read Margin].
A pop-up menu will appear. Select (DR) [Running
Status].

Monitar
Leg
Esvironment Monhos...
Bioned Treck

Threahold Value Menager &
Online Head Matjin Qver Rete Dieplay

Dicshotd Ve
=

(2) In the ‘ORM Running Status Display’ dialog box, the ORM _ _
running status is displayed as the number of sectors. T TR

Times
. @ ” 15 2 3]
Note: The “HDD#" list box shows the location numbers of Ezm E Eﬂ ol
14 4l . 7880 70e+00¢
HDDs. “Scan” shows the number of scanned sectors. im E §§ e
“Total” shows the total number of sectors in the 17807502008 / 84T
H corps 3> . . 1.7880780+006 / B.014571
drive. “Times” shows the number of times the entire 1707504006 | 84T ]
dri ed RISTORXS4S 1 7omirieedok ; &M eos i)
Ve was scanned. |RIS(DK 30645 V78807804006 / BUTAETIes006 [02)
R167TDK06-45] 1.7880780+006 / ROT4ET1e+006 [0.2]
R17TDKI06-45] 1.780070e+006 / BO14571e+008 [0.2)
:

(3) Select (CL) [Close] in the ‘ORM Running Status Display’
dialog box and close the ‘Information’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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[6] Resetting thresholds

(1) Select (CL) the [Mode] menu in the ‘Information’
window and select (DR) [Modify).

Eile View

View

(2) Select (CL) the [View] menu in the ‘Information’
window and select (DR) [Online Read Margin].
A pop-up menu will appear. Select (DR) [Initialize
Threshold Value].

Emdronment Monhtor...
Pinned Tracke

Ihrechold Value Manager  »
Owver Aste Displey
Parity Emror... | Threshold Value D

| Maintenance History... Bunning Status
Inialize Threzhold Value

(3) The message “Please wait a moment.” is displayed.

(4) Select (CL) [OK] in the ‘Initialize Threshold Value’
dialog box.

Initialize Threshold Value

0 Initializing the threshold value is finished.

Copyright ©1996, Hitachi, Ltd.
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10.2.7 SIM Reporting Specification

{11 DKC SIM : SVP02-350
[2] Cache SIM SVP02-360
[3] Media SIM SVP02-370

[4] Device SIM SVP02-380

(1) Select (DC) the [Information] icon in the ‘SVP’ window.

Svp
|
Status Diag

Fdcopy Install Online

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright (C} 1994,1995,Hitachi,Ltd.

(3) Select (CL) the [View] menu in the “‘Information’ window
and also select (DR) [Log]. 5

Intarmatan
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[1]DKC SIM

(1) Select (CL) the [Option] menu in the ‘Information’
window and also select (DR) [SIM Report]. A pop-up
menu will be displayed. Select (DR) [DKC SIM...].

SIM Repan DEC SiM..,

OssBien

OMie P O
O Detali Loy Bas]  Osalen
O Resctlon s

(2) Select (CL) the level to be reported in the
‘DKC SIM Report.‘u_xg Option’ dialog box, and also
select (CL) [OK].

SIM message report level are arranged as follows in
order of the higher level.

Acute > Serious > Moderate > Service

Selecting of a level means all higher levels are to be
reported.

Reporting
Racste X Moderate
X sesious & sesvice

| DKC SIM Reporting Option |

Report: Acute Serious_ Modesate and Sesvice

(3) Close the ‘Log’ dialog box and also close the
‘Information” window.

Copyright ©1995,1996, Hitachi, Ltd.
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[2] Cache SIM

(1)  Select (CL) the [Option] menu in the “Information’
window and also select (DR) [SIM Report].
A pop-up menu will be displayed. Select (DR)
{Cache SIM....].

Intormatinn

Flie Edit  Yiew QT
SIM Repon

Cnche S

OSSBiem DasT Mt Dasy;
OShilay s N BasT
O Detall Log BasT  Ofaim Hareing
OResetlog st

O Power Event Log (>

(2) Select (CL) the level to be reported in the ‘Cache SIM

Reporting Option’ dialog box, and also select (CL)
[OK].

SIM message report level are arranged as follows in
order of the higher level.

Acute > Serious > Moderate > Service

Selecting of a level means all higher levels are to be
reported.

Cache SIM Reporting Option

(3) Close the ‘Log’ dialog box and also close the
‘Information’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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[3] Media SIM

(1) Select (CL) the [Option) menu in the ‘Information’
window and also select (DR) [SIM Report].
A pop-up menu will be displayed. Select (DR)
[Media SIM...).

2 Intirmatinm
e Edt  Yiew FTTIT
] RIM Repun

(2) Select (CL) the level to be reported in the “Media SIM
Reporting Option’ dialog box, and also select (CL)
[OK].

Media SIM Reporting Option

Reporting | 0K |

K Sesious [ Service

SIM message report level are arranged as follows in
order of the higher level.

Acute > Serious > Moderate > Service

Selecting of a level means all higher levels are to be
reported.

Report: Acute, Serious, Moderate and Service

(3) Close the ‘Log’ dialog box and also close the
‘Information’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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[4] Device SIM

(1) Select (CL) the [Option] menu in the ‘Information’
window and also select (DR) [SIM Report).
A pop-up menu will be displayed. Select (DR)
[Device SIM...].

(2) Select (CL) the level to be reported in the ‘Device SIM
Reporting Option’ dialog box and also select (CL) [OK]).

SIM message report level are ari-anged as follows in
order of the higher level.
Acute > Serious > Moderate > Service

Selecting of a level means all higher levels are to be
reported.

Reporting
X Acute

Device SIM Reporting Option

K Sesious  [X Service

X Modesate

Report

Acate_Sesiour. Modesate and Service

(3) Close the ‘Log’ dialog box and also close the
‘Information’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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10.2.8 Management of drive threshold values

[1] Displaying threshold values : - SVP02-400
[2] Altering threshold value SVP02-410
[3] Displaying an error count SVP02-430
[4] Resetting an error count SVP02-440

(1) Select (DC) the [Information] icon in the ‘SVP’ window.

(2) Select (CL) [OK] in the ‘SVP” dialog box.

Copyright [C] 1994,1985, Hitachi,Ltd.
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[1] Displaying threshold values

(1) Select (CL) the [View] menu in the ‘Information’
window and also select (DR) [Threshold Value Eile Mgdz
Manager]. A pop-up menu will be displayed.
Select (DR) [Threshold Value A/D].

Thieuliold Value 4T

Maimenunce History.. |

(2) Select (CL) an HDD location from the “HDD#” list box in the
“Threshold Alter/Display® dialog box and select (CL) T —
[Display]. : (Gen]] || woomoo

isplay threshold of another interval, select (CL) ||[%2; || e "
In order to display thresho @Tdom  OTowl Mochamcal emcs E
the interval from the “Type” list box. "
Note: Multiple HDD locations can be selected (CL)
from the “HDD#” list box while the control key
being held down. The threshold value in the
“Threshold Value” list box shows the threshold
valu for the HDD location that is highlighted in
the “HDD#” list box.

Recovered: Threshold of errors recoverable by retry. [T

Unrecd: Threshold of errors not recoverable by retry. Gz | || woomz

SCSt IF emox ]

SCSI port 0 eeror

L
I

SCS| port 0 emvor

(3) Select (CL) [Close] in the “Threshold Alter/Display’
dialog box and close the ‘Information’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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[2] Altering threshold value

(1) Select (CL) the [Mode] menu in the ‘Information’
window and also select (DR) [Modify].

(2) Select (CL) the [View] menu in the ‘Information’

window and also select (DR) [Threshold Value Eile g o

Manager]. : o O

A pop-up menu will be displayed. e e e
Select (DR) [Threshold Value A/D]. e

Meintcnunce History.. J

(3) Select (CL) an HDD location from the “HDD#” list box
. < . 5 1t hrechald AlterDisplay
in the ‘Threshold Alter/Display’ dialog box and select (CL) = e

FHDOR ] [ Theashold Valsc

[Display]. In order to display threshold of another interval, HOD:R100 [a=]
. ” 9 ye Typo Erroe Tope Recovered Umrecd
select (CL) the interval from the “Type” list box. @7dope O Tatwl Meochesical emox EJ

Meda o ] EJ
Read / Write ewrer E
D E_]
oot bt e (50| £
SCSI UF emor E1

SODEKI06-45] SCS! port 0 errer E
unmm SCS! port 1 arrex 2] m

(4) Alter a threshold value in the “Threshold Value™ list box
" in the “Threshold Alter/Display’ dialog box.

Then select (CL) [Alter].

Note: When multiple HDD location are selected (CL)
from the “HDD#” list box while the control key
being hold down, the thresholds for the all selected
HDDs are modified to the same value.

Thre<hald AterDizplay

F Thashok! Vekse

—

Error Type . Recovered Unrocd
e o EJ
M e ] B
Reed / Writo sarex ||
D )
Controler hasdware swwor E
SCS! I/F sarox |G|
SCS1 port 0 ever (|

SCS! port 1 enex E [ow |

Copyright ©1995,1996, Hitachi, Ltd.
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(5) Select (CL) [OK] in the ‘Alter Threshold Value’ dialog
box. = Alter Threshold Value

Are you sure you want to alter the threshold
value of the HDD you selected ?

(6) Select (CL) [Close] in the ‘Threshold Alter/Display’
dialog box and close the ‘Information’ window.

Copyright ©1995, Hitachi, Ltd.
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[3] Displaying an error count

(1) Select (CL) the [View] menu in the ‘Information’ window

and also select (DR) [Threshold Value Manager]. e Y wsce
A pop-up menu will be displayed. b eoene
Pwned Track..

Select (DR) [Error Count Display].

Threshold Velue AD

ar Lannt Display

Thorealould Yalue Masager

QOnling Rasd Margin
Parity Error,

Muintenance History... ]

(2) Select (CL) an HDD location from the “HDD Location”
drop-down list in the “Threshold Counter Display’
dialog box to display the error count for the HDD.

HDD Location: GIITGE LRI

[SCSI port 1 enoe

Today:[Emor Count / Threshold Vaiue:Wamingll evell Level2) Slockade{Levell Leve2]]
7 doe.Torak:] Evror Count / Threshold Value |

(3) Select (CL) [Close] in the “Threshold Counter Display’
dialog box and close the ‘Information’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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[4] Resetting an error count

(1) Select (CL) the [Mode] menu in the ‘Information’ wmdow

and also select (DR) [Modify]. Yiew
View
(2) Select (CL) the [View] menu in the ‘Information’ window
and also select (DR) [Threshold Value Manager]. Elc R Mase
A pop-up menu will be displayed. Select (DR) [Error e
Count display]. i

Threslwld Yalue Manauer
QOnlinz Aead Margin
Parity Ermor.

Muimenance History... r

Threshold Velue AD
1 tear vnnnt Dhisplay

(3) Select (CL) the HDD location , for which you want to
reset the error count, from the “HDD Location”
drop-down list in the “Threshold Counter Display’
dialog box and also select (CL) [Reset].

0000L 1

Read / Wiske erree freceversd] D000 2. 10L0200.100) 0D000000/6

(recerracnd) 50011 000, 5007 15

5;"‘ et wrvor 000K  SULIT 000, 500] ll::nnng

frocoversd) 00000000/TS 5011 000.500)  0O00O000/Y

.':nulim DO000000.T! ZL[20.10) 00000000/3

Macha orer [unrscerrared)] DO000OUELT SLI100.50) 000000003

Fisad / Wiks weror fuwecovessd] 0000000/ 2L120,10) O3

Deve |F srvor funrsccreesed) 000000 21020100 0000000073

Cantroic e | 210010

SCS1 F oo &l DD00DN00/3

.-‘-nl:_lllﬂr.h—l] %ﬂ m A
SCS1 port 1 enven DO000CDO/T4LIT) 0000000012 -

eday[Emor Count / Thrasheld Vahus Wermingllevell Lovel2) SlockadelLovell Level2D)
7 I*J':zl Erer Count / Thrashold Valus ]

(4) Select (CL) [OK] in the “Threshold Counter Reset’
dialog box.

Threshold Counter Reset

Are you sure you want to reset Threshold
Counter of all ID?

ok | |cancet |

Copyright ©1995,1996, Hitachi, Ltd.
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(5) After confirming that the error count has been reset

in the *"Threshold Counter Display’ dialog box select | T e |

(CL) [Close] and close the ‘Information’ window.

Todaw[Enes Count 7 Threshold Value W arningiL ovel] Level2] Blockade(Levell Level2]]
7 daye.Totet| Ermoe Count / Threshold Value |

Copyright ©1995,1996, Hitachi, Ltd.
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10.2.9 DUMP/LOG FD Copy

The first operation.
(1) Select (DC) the [Fdcopy] icon in the ‘SVP’ window.

Information Status Diag
'l
Orine

(2) Select (CL) [OK] in the ‘SVP’dialog box.

Copyright (C) 1995, Hitachi,Ltd.
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Copying the dump and log files to 2 floppy disk.

(1) Select (CL) [START] in the ‘Fdcopy” dialog box.

]

File

Please, select "STRAT" for files to compress
and copy to FD. ’

(2) The message “Please insert a DOS formatted FD
(NO.1) ” will be displayed in the ‘FD SET’ dialog box.
In response to this message, insert a ﬂopby disk and
select (CL) [OK]. Please insert a DOS formatted
FD [Ne.1)
Note: ~ When the ejective button of the FDD is pushed
the FD is jumped out. . Do not drop the FD.

td

Copyright ©1995, Hitachi, Ltd.

[(7ev.5 1995 npr 1985 [ s 199 [Se. 1995 o190 [owm 1259 SVP02-470




K6600890-

(3) If the floppy disk contains files, the message “FD contain
these files. Do you want to delete them 7" is displayed.

If you want to delete these files, select (CL) [YES] and FD contain these files.
proceed to step (5). Do you want to delete them?
If you don’t want to delete these files, select (CL) [NO] :z:iil:::p
and proceed to step (5). error.bmp

. - finder.dat
If an error occurs, check the items indicated by the history.dmp

‘ACCESS ERROR!!" dialog box then select (CL)
[Retry].
(You will go back 1o the beginning of step (4).)

= ACCESS ERROR 1!

Could not access FD.
FD is not DOS formatted.
FD is not inserted.

FD is write protected.

Retry Cancel

(4) The message “Compressing files...” is displayed, and

compressing is started.
Compressing files ...

DKCZ00\DUMPY*.*

(5) The message “Copying files to FD...” is displayed, and .
copying is started.
(If the capacity of the floppy disk becomes insufficient,
8o back to step (2) and replace the floopy disk with a
new one.)

Copying files to FD ...

DKC200{TMP\fdcp.izh

Copyright ©1995, Hitachi, Ltd.
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(6) The message “Delete DUMP files in HDD.” is displayed
in the ‘DUMP DELETE’ dialog box.
Select (CL) [OK] and delete DUMP files in HDD.

(7) Close the ‘Fdcopy’ dialog box.

Copyright ©1995, Hitachi, Ltd.
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Blank Sheet

Copyright ©1995, Hitachi, Ltd.
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10.2.10 SIM Log Complete

(1) Select (DC) the [Information] icon in the ‘SVP’ window.

Status Diag
Fdcopy Install Online

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

(3) Select (CL) the [Mode] menu in the ‘Information’
window and select (DR) [Modify].

. Intormation
Flle View §YCTTY

Copyright ©1995, Hitachi, Ltd.
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(4) Select (CL) the [View] menu in the ‘Infonhation’ )
window and select (DR) [Log]. Eile Mgde

Monnor

4

Ewvircament Moaitar...
Blancd Track,

Ihresbold Valoe Massger  »
Oaline Read Margin ¥

Malntvance Histore,

(5) Select (CL) [SIM Log] in the ‘Log’ dialog box.

Select (CL) the [View] menu in the ‘Information’ mﬁ

. . . =] log f 1=
window and select (DR) [List]. pp— O tectemting
O s Log COMA O LCPMCP Lea easn
QO Detall Log B3ST] O Disg Log Basn
O ResetLog ©asT

O Power Event Log feasT)

(6) Select (CL) data to be completed in the ‘SIM Log’ dialog
box and select (CL) [Complete].

(7) Select (CL) [OK] in the ‘Complete’ dialog box.
= Complete

o This will complete the SIM#5.

oK Cancel

Copyright ©1995, Hitachi, Ltd.
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(8) Inthe ‘SIM Log’ dialog box, [Status] is displayed.

(9) Select (CL) [OK] in the ‘SIM Log’ dialog box.
Close the ‘Log’ dialog box and close the ‘Information’
window.

Copyright ©1995, Hitachi, Ltd.
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10.2.11 Dump
[1] Manual Dump

(1) Select (DC) the [Install] icon in the ‘SVP’ window.

ﬁ

Information Status Diag
Fdcopy  Irictall] Online

(2) Setect (CL) [OK] in the ‘SVP’ dialog box.

Copyright (C} 1994,1995, Hitachi, Ltd.

OK

(3) Select (CL) the [Mode] menu in the ‘Install’ window and

select (DR) [Modify]. WL

(4) Select (CL) the [Install] menu in the ‘Install’ window and

select (DR) [Manual Dump...]. -Ein: N =
Define Configuration and Install...
Befer Configuration...
System Tuning...

Logical Device Format...
Manual Dump...

MP Install...

System Time...

Set IP Address...

PCB Revision Display...

Copyright ©1995,1996, Hitachi, Ltd.
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(5) Select (CL) processor in the [Location No.] in the
‘Manual Dump’ dialog box, and select (CL) [OK].
[All processors] indicates that dumps for all processors Location Na.
are collected. © AN Processons|

CoaiEg OcHalE Coazw Oovag

Oora1g Ooraid Obraty OpraIg

Obrar Oopra Ooram Oorazr

(6) The message “Manual Dump receiving...” is displayed in
the ‘Manual Dump’ dialog box.
Note: “LCP” is displayed as a processor name during
the collection of the dump for MCP.
(Within about 1 minute)

Manual Dump

Manual Dump receiving...

If you selected [All processors] at step (5), the message
“LM/SM Dump receiving...” is displayed in the 1
Touch Dump’. (about 1 minute/processor)

LM/SM Dump receiving...

(7) Select (CL) [OK] in the ‘Manual Dump’ dialog box.

= Manual Dump

If you selected [All processors] at step (5), select (CL) [OK] in
the ‘1 Touch Dump’.

Copyright ©1995,1996, Hitachi, Ltd.

| REV.S IIApr.1995|Jun.1995]Jul.1995|Dec.1995|Mar.1996|May.1996| SVP02-550




K6600890-

(8) If you want to copy the Dump file to a floppy disk, perform
‘Dump FD Copy’.
(Refer to 10.2.9 DUMP/LOG FD Copy)

(9) Close the ‘Install’ window.

Copyright ©1985, Hitachi, Ltd.
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[2] SSVP DUMP

(1) Set the SSVP ALARM RESET/DUMP switch to DUMP position.
(see “2.3.2 Other switches and LEDs” on page LOCATIONO03-30.)

(2) Open STATUS display (see STATUS section).
Confirm that the message “SSVP Dump is being
performed [XXXX]. Environment status can’t be read.”
is displayed and select [OK] (CL).

If the message “Connection error occurred. SVP-SSVP” is
displayed, check the wiring connection and select [OK] (CL)
to start from step (1) again.

If step (1) is performed three times and the same message
“Connection error occurred. SVP-SSVP” is displayed,
replace SSVP (see REP01-150).

General Status Display

(3) SSvp ALARM lamp blinks after completion of dump.

(Within about 40 minutes after performing step (1))

(4) Copy dump file to FD.
Perform “10.2.9 DUMP/LOG FD COPY™ on page SVP02-460

Copyright ©1995,1996, Hitachi, Ltd.
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(5) Set SSVP ALARM RESET/DUMP switch to RESET position and implement SSVP again.
(see “2.3.2 Other switches and LEDs” on page LOCATIONO3-30.)

(6) Open STATUS display.
Confirm that the message “Initalizing SSVP [XXXX].
Please wait.” is displayed and select [OK] (CL).

If the message “Connection error occurred. SVP-SSVP” is
displayed, select [OK] (CL) to perform step (5) again.

If step (5) is performed three times and the same message
“Connection error occurred. SVP-SSVP” is displayed,
replace SSVP (see REP01-150).

(7) Open STATUS display again after waiting for about 20 minutes.
If two messages shown at step (6) are not displayed, the SSVP implementation is completed.

Copyright ©1995, Hitachi, Ltd.
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[3] TPF Dump

(1) Select (DC) the [Install] icon in the ‘SVP’ window.

Information Status Diag
Fdcopy Online

(2) Select (CL) [OK] in the ‘SVP’ dialog box.
=

Copyright [C) 1994-1996,Hitachi,Ltd.

(3) Select (CL) the [Mode] menu in the ‘Install’ window
and select (DR) MOdlfY] =] o Install -0

!-u'l'lhl' l

(4) Select (CL) the [Install] menu in the ‘Install’ window
and select (DR) [TPF Dump].

[ Install [ «]

| Bile MEETEUN Mpde

Define Configurstion and Install— "
Define Configurstion—.

|watall..

Logicsl Device Format..

Manual Dump...

MP lestall..
Sywtem Time..
1'% UDump
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| REV.0 JIET.1997I I | | | ] SVP02-554




K6600890-

(5) Select [OK] (CL) in response to “TPF Dump received.”.
If you want to copy the Dump file to a floppy disk, perform
‘Dump FD Copy’.
(refer to 10.2.9 DUMP/LOG FD Copy)

Copyright 1997, Hitachi, Ltd.
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10.2.12 Logical Device Maintenance

[1] Physical Device List SVP02-580
[2] FORMAT Logical Device SVP02-590
[3] Block Logical Device SVP02-610
[4] Restore the Logical Device SVP02-630
[5] Refer the system configuration data SVP02-650
[6] Verify Logical Device SVP02-655
[7] LDEYV recovery for multiple PDEV failure SVP02-658

(1) Select (DC) the [Online] icon in the ‘SVP’ window.

Information Status Diag

5B 8§ 8

Fdcopy Install

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright (C) 1994,1995,Hitachi,Ltd.

(3) Select (CL) the [Mode] menu in the ‘“Maintenance Online’
window and also select (DR) [Modify].

Copyright ©1995,1996, Hitachi, Ltd.
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(4) Select (CL) the [Maintenance] menu in the ‘Maintenance
Online’ window and also select (DR) [Logical Device
Maintenance...).

“Logical Device Maintenance List” is displayed.

Muntenance Ontne

Copyright ©1995, Hitachi, Ltd.
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[1} Physical Device List

(1) Select (CL) an LDEV from the LDEV list box in the
‘Logical Device Maintenance List’ dialog box and i Logical Device Maintenance List
select [Pdev List...].

T 7 B
g Dol
8 R
06 11 [Normal] Blockade...
07 11 [Nomal] n

Renewal

(2) ‘Disk Drive List’ is displayed.
And select (CL) [OK]. . , Disk Drive List

HDD-R107
HDD-R117
HDD-R127
HDD-R137

HDD-R100
HDD-R110
HDD-R120

(3) Select (CL) [Close] in the ‘Logical Device Maintenance List’
dialog box.
Close the ‘Maintenance Online’ window.

Copyright ©1995,1996, Hitachi, Lt
| revz [ apr.1905 [sun.1905 | Aug.1s06] | ! | SVP02-580




K6600890-

[2] FORMAT Logical Device

NOTICE
Executing this operation may cause a serious error such as a system down or a data loss. Accordingly, confirmation
of the appropriateness of the operation and input of a password on the succeeding password input screen is required.

(1) Select (CL) an LDEV from the LDEV list box in the
‘Logical Device Maintenance List” dialog box and

LDEV Group Status
select (CL) [Format...]. T e
0 11 [Blocked] _m
03 11 [Blocked]
: . - ocked)
Note: Execute Format Logical Device after you o4 11 [Blocked]
5 - [Blocked]
confirm the target Logical Device is blocked. e Placked

(2) Select (CL) corresponding item from the target list in the
‘Format Logical Device’ dialog box and select (CL) [OK].

Format Logical Device

Targel

If target LDEV was not blocked, return to ‘Logical Device
Maintenance List’ dialog box after message displayed.

@ Specified logical device

O Parity group specified by logical device

Target LDEY ID: 00

Ok —I | Cancel

(3) “Data housed in the specified logical device will be lost
due to this operation. You need the password to
continue.” is displayed.

Enter the password and select (CL) [OK].

Data housed in the specified logical

device will be lost due to this operation.
You need the password to continue.

NOTICE
This is a special (exceptional) operation that can cause a serious failure such as a system down or a data loss and
requires an input of a password. Ask the technical support center about the appropriateness of the operation, and

input the password after getting an approval of executing the operation.

Copyright ©1995,1998, Hitachi, Ltd.
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Online Maintenance

Reading the subsystem configusation data..

(4) “Reading the subsystem configuration data...” is displayed,
and then “Formatting the logical device...” is displayed.

(5) Select (CL) [OK] in response to “Formatting the logical
device is completed.”.

o Formatting the logical device is completed.

(6) Select (CL) [Close] in the ‘Logical Device Maintenance -
List’ dialog box.
Close the ‘Maintenance Online’ window.

Copyright ©1985,1996, Hitachi, Ltd.
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_ [3] Block Logical Device

NOTICE
Executing this operation may cause a serious error such as a system down or a data Ioss. Accordingly, confirmation
of the appropriateness of the operation and input of a password on the succeeding password input screen is required.

(1) Select (CL) an LDEV from the LDEYV list box in the

Restore...

LDEV Logical Device is blocked.

‘Logical Device Maintenance List’ dialog box and l.nﬂi:ﬁqnt:vilﬁt’. Maintenance List
select (CL) [Blockade]. B e —
9 11 et
B e
NOTICE o B 11 o
Excute Format Logical Device after you confirm the 07 14 [Normal]

Renewal

(2) Select corresponding item from the target list in the
‘Block Logical Device’ dialog box and select (CL) [Ok].

Block Logical Device

Target

@® Specified logical device

NOTICE
Execute Format Logical Device after you confirm the
target Logical Device is blocked.

O Paiily group specified by logical device

Target LDEV ID: 00

[_ox |

L Cancel

(3) “Data housed in the specified logical device may be lost
due to this operation. You need the password to
continue.” is displayed.

Enter the password and select (CL) [OK].

Data housed in the specified logical

device may be lost due to this operation
You need the password to continue.

NOTICE

This is a special (exceptional) operation that can cause a serious failure such as a system down or a data loss and
requires an input of a password. Ask the technical support center about the appropriateness of the operation, and
input the password after getting an approval of executing the operation.

Copyright ©1995,1998, Hitachi, Ltd.
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(4) “Reading the subsystem configuration data...” is displayed,
and then “Blocking the logical device...” is displayed.

Online Maintenance

Reading the subsystem configuration data_..

Hardware Maintenance

Blocking the logical device...

(5) Select (CL) [OK] in response to “Blocking the logical
device is completed.”. Hardware Maintenance

o Blocking the logical device is completed.

OK

(6) Select (CL) [Close] in the ‘Logical Device Maintenance
List’ dialog box .
Close the ‘Maintenance Online’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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[4] Restore the Logical Device

NOTICE
Executing this operation may cause a serious error such as a system down or a data loss. Accordingly, confirmation
of the appropriateness of the operation and input of a password on the succeeding password input screen is required.

(1) Select (CL) an LDEV from the LDEV list box in the
‘Logical Device Maintenance List’ dialog box and

T —
SeleCt (CL) [ReStore] o 1-1 Blocked
8 0 e
B o0 e
= o
R -
- [Blocked]
o el (o]
Renewal l

(2) “Do you want to restore Logical Device and Physical

Device? Yes : Logical Device and Physical Device Hardware Maintenance
No : Logical Device only” is displayed. Select (CL) Do you want to restore Logical Device and
[No]. Physical Device ?

Yes : Logical Device and Physical Device
No : Lagical Device enly

|!esl|ﬂo|

(3) Select (CL) corresponding item from the target list in the
‘Restore Logical Device’ dialog box and select (CL) [OK].
If “Forcibly’ is selected, Message is displayed in the ‘Confirm’ Target
dialog box. Enter the password and select (CL) [OK]. @ [Specified iogical device:

© Paily group specified by logical device

Target LDEV ID: 0D
[ Forcibly

NOTICE
This is a special (exceptional) operation that can cause a You need agreement of Technical
serious failure such as a system down or a data loss and ® ﬁ:ff:;‘,“,:_ enter. and entering the

requires an input of a password. Ask the technical
support center about the appropriateness of the operation,
and input the password after getting an approval of
executing the operation.

Password: :

.Copyright ©1895,1998, Hitachi, Ltd.
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(4) “Reading the subsystem configuration data...” is displayed,
and then “Restoring the logical device...” is displayed.

Online Maintenance

Reading the subsystem configuration data...

Hardware Maintenance

Restoring the logical device...

(5) Select (CL) [OK] in response to “Restoring the logical

device is completed.”. — Hardware Maintenance

0 Restoring the logical device is completed.

(6) Select (CL) [Close] in the ‘Logical Device Maintenance
List’ dialog box.
Close the ‘Maintenance Online’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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[5] Refer the system configuration data

(1) Select (CL) [Renewal] in the ‘Logical Device
Maintenance List’ dialog box.

(2) “Reading the subsystem configuration data...” is
displayed.

Hardware Maintenance

Reading the subsystem configuration data...

(3) Select (CL) [Close] in the ‘Logical Device Maintenance
List’ dialog box.
Close the ‘Maintenance Online’ window.

Copyright ©1995,1996, Hitachi, Ltd,
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[6] Verify Logical Device
NOTICE

Executing this operation may cause a serious error such as a system down or a data loss. Accordingly, confirmation
of the appropriateness of the operation and input of a password on the succeeding password input screen is required.

(1) Select (CL) an LDEV from the LDEYV list box in ‘Logical
Device Maintenance List’ dialog box and select (CL)
[Verify...].

01 1- [Nomal] Pdev List...
02 3-

[Normal]
a3 1-
04 1-
gg -}: }:m% Blackade...
07 1- [Normal}

L X Y A N AP ey
3z
41

Renewal

(2) Select (CL) corresponding item from the target list in the
‘Verify Logical Device’ dialog box and select (CL) [OK].

] Verify Logical Device

Target
If target LDEV was not normal, return to ‘Logical Device @® {Specified iogical device;
Maintenance List’ dialog box after message displayed. O Parity group specified by logical device ‘

Target LDEV ID: 0D
X Auto Comect Enor Stop:

I Cmcel“

Enter the password and select (CL) [OK].

NOTICE

This is a special (exceptional) operation that can cause a
serious failure such as a system down or a data loss and
requires an input of a password. Ask the technical
support center about the appropriateness of the operation,
and input the password after getting an approval of
executing the operation.

! You need the password to continue.

(3) “Verifying the logical device...” is displayed.

Verifying the logical devices...

Copyright ©1996,1998, Hitachi, Ltd.
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(4) If parity has errors less than the specified “Error Stop”,
“Verifying the logical device is finished.” is displayed.

0 Verifying the logical devices is finished.

(5) If parity has errors more than the specified “Error Stop”,
“Verifying the logical device is stopped.” is displayed.

0 Verifying the logical devices is stopped.

OK

(6) If [Stop] is sclected (CL) and [OK] in response to
inquiry message is selected (CL), “Verifying the logical
device is interrupted by SVP.” is displayed.

0 Verifying the logical devices is interrupted by
SVP,

(7) Select (CL) [OK] in response to the message (4) ~ (6).
Select (CL) [Close] in the ‘Logical Device Maintenance
List’ dialog box, Close the ‘Maintenance Online’ window.

(8) Confirm the Parity Error.
(See 10.2.21 Parity Error indication)

Copyright ©@1996, Hitachi, Ltd.
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[71LDEYV recovery for multiple PDEV failure

(1) Select (CL) an LDEV from the LDEV list box in the
‘Logical Device Maintenance List’ dialog box and

seleCt [Res.tore]. 00 1-1 Blocked
6o R
o e
.

1-1
06 11 [Blocked Blockade...
07 11 [Blocked] —m
Repewal

(2) “Do you want to restore Logical Device and Physical
Device? Yes : Logical Device and Physical Device
No : Logical Device only” is displayed. Select (CL)

Do you want to restore Logical Device and
[Yes]. Physical Device ?

Yes : Logical Device and Physical Device
No : Logical Device only

(=] (]

(3) “Restoring the logical device is completed.” is displayed.
Select (CL) [OK].

Hardware Maintenance

0 Restoring the logical device is completed.

(4) Select (CL) [Close] in the ‘Logical Device Maintenance List’ dialog box.
Close the ‘Online Maintenance’

Copyright ©1996, Hitachi, Ltd.
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10.2.13 Pin Data indication

Prerequisite operation
(1) Select (DC) the [Information] icon in the ‘SVP’ window.

SYP

Status

Infarmation

Fdcopy

Install

Online

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright [C] 1994,1995,Hitachi,Lid.

(3) Select (CL) the [View] menu in the ‘Information’
window and select (DR) [Pinned Track...].

Made

Monltor

Emvironment Monhor. ..

TIhreshold Value Mansger |
Online Read Margin »

MEInmBnLs Biutany

Copyright ©1995, Hitachi, Ltd.
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(4) LDEY to exist Pin Slot is displayed. Select (CL)
LDEYV to be indicated in the ‘Pin Volume’ dialog
box and select (CL) [Detail...].
Logical Device 03
(Note) When Pin Slot recovered, LDEV to be reported m@:z gﬁ o

Pin Slot SIM is not displayed. Lovical Device 07

(5) Detail of Pin Slot is displayed.
(When “No.” exist more than 17, select (CL) [Next].)
(Note) When impediment of Slot can recover, detail of

1 2808 DATA Write ertot HDD-A107 DOCOOO  0OOO 00
2 28 0C PRTY ECC/LRC enoc HDD-R107 00000C 0000 0O
Pin Slot iS not displayed- 3 maAanc PRTY ECC/AAC eror HDD-R107 0ODOOC 0000 0O

(6) Select (CL) [Close] in the ‘Detail’ dialog box.
Select (CL) [Close] in the ‘Pin Volume’ dialog box.
Close the ‘Information’ window.

Copyright ©1995, Hitachi, Ltd.
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10.2.14 MP Restart

NOTICE
This is a special (éxccptional) operation. Ask the technical support center about the appropriateness of the operation.

[Over view]

This facility is used to restore a processor in a DKC that is placed in a failed state due to a logical inconsistency. It
may be used in cases there a processor is in the WCHK 1 state or both processors in a CHA are in the failed state. In
such cases, the replace function of MP Restart must be used.

(1) Select (DC) the [Online] icon in the ‘SVP’ window. .

Informatian Status Diag
Fdcopy Install

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright [C) 1994,1995,Hitachi,Ltd.

0K

(3) Select (CL) the [Mode] menu in the ‘Maintenance Online’
window and also select (DR) [Modify].

Maintenance Dnline

Elle  Maintenance MEUGT

= Modity

Copyright ©1995,1998, Hitachi, Ltd.
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(4) Select (CL) the [Maintenance] menu in the ‘Maintenance

Online’ window and select (DR) [Hardware Maintenance]. Maintenance Online
I3[ Maintenance

Hardware Maintenance

Software Maintenance »

Logical Device Maintenance...

System Qption...

Juning parameter

Online Patch »
|_Change Subsystem »

(5) Select (CL) the [MainPlatter] in the ‘Hardware
Maintenance, Window. I . M‘:Lrl-::::z:r
Select (CL) the [Maintenance] menu in the ‘Maintenance
Online’ window and select (DR) [Maintenance].

OHOURIT MNORMAL | O HDULI! EMPTY

Make sure that the ‘Status’ of [Mainplatter] is OHDURIZ NORMAL | OHOULI2 JEMPTY

O omers OHDURII NORMAL | O HDULI3 EMPTY
[WARN[NG] OHOURIA EMPTY )| OHOULI4 EMPTY
OHOURIS EMPTY | OHDULIS EMPTY
OHOUAIE EMPTY | OHDULIG EMPTY
OHDURIT EMPTY | OHDULI? EMPTY

Hardwnre Mainienance

OHDURIS MORMAL | O HDULIS [EMPTY

P I S ppe—

(6) Select (CL) the [CHAnn] or [DKAnn] to be restarted in the
‘MainPlatter Maintenance’ window.
Select (CL) the [Maintenance] menu in the ‘Maintenance
Online’ window and select (DR) [MP Restart).

Mamtcnnnce Onbing

(7) Inresponse to the message “Are you sure you want to
restart the Micro processor?”, select (CL) [Yes). =] Hardware Maintenance

Are you sure you want to restart the Micro
processor?

Copyright ©1995,1996, Hitachi, Ltd.
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(8) “Waiting for Power Event...” is displayed.

Hardware Maintenance

Waiting for Power Event...

(9) Inresponse to the message “This PCB restarting is done.”,
select (CL) [OK]. Hardware Maintenance

This PCB restarting is done.

(10) “Reading the subsystem configuration data...” is
displayed.

Hardware Maintenance

Reading the subsystem configuration data...

(11) Close the ‘Maintenance Online’ window.

Copyright ©1995,1996, Hitachi, Lid.
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10.2.15 FD Backup
[1] Micro Program SVP02-710
[2] Configuration SVP02-731
[1] Micro Program

(1) Select (DC) [Install} icon in the ‘SVP’ window.

= T —

Information Status Diag
o0 8 8
Fdcopy inatall Oniine

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

(3) Select (_CL) the [Mode] menu in the “Install’ window
and select (DR) [Modify]. Thie_jostall ]

(4) Select (CL) the [File) menu in the ‘Install’ window and

H Install
select (CL) [FD Backup] and select (DR) [Micro I lnctall Made
Program...]. FD Backup Micro Program....

Copyright ©1995,1996, Hitachi, Ltd.
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(5) The microprogram types and HD versions are displayed.
Select (CL) {OK].

lE

o1-42-20-00/90
a-ann
ane

fn-0-m
91-00-88
18800
61-80-03
010003

[ o]

-

TN

(6) Inresponse to the message “Insert FD No.n in FDD”,
remove the inserted floppy disk and select (CL) [OK). FD Backup
(n=2,3,------,;n n:Number of floppy disks)

0 Insert FD No.n in FDD

(7) Copying HD files to FD.

FD Backup

Copying HD files to FD [DKCMAIN)
c\dkc200\mp\dkc\cha\acmloadc.pig

Copyright ©1995,1996, Hitachi, Ltd.
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(8) Upon completion of reading from all the floppy disk,

the message “Remove FD No.n” appeared. - - FD Backup

In response to this message, remove the floppy disk

and select (CL) [OK]. o Remove FD No.n
(n:Number of floppy disks)

(9) Close the ‘Install’ window.

Copyright ©1995, Hitachi, Ltd.
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[2] Configuration

Install information
(1) Select (DC) [Install] icon in the ‘SVP’ window.

Fdcopy Instal Online

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright (C) 1994,1995,Hitachi,Ltd.

(3) Select (CL) the [Mode] menu in the ‘Install’ window
and select (DR) [Modify]. e - jorta .

(4) Select (CL) the [File] menu in the ‘Install’ window and
select (CL) [FD Backup] and select (DR) [Configuration].

Install

Contiquration

Copyright ©1995,1996, Hitachi, Lid. _
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(5) Insert the Configuration FD into FDD, select (CL) [OK].
FD Backup

0 Please insert config FD in FDD.

(6) When this procedure is completed, message “Backup is
done. Remove FD.” is displayed.
Remove the FD, select [OK].

= FD Backup

0 Backup is done. Remove FD.

OK

(7) Close the ‘Install’ window.

Copyright ©1995,1996, Mitachi, Ltd.
[ REv.: INov.1995[Mar.1996| | | [ | SVP02-732
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10.2.16 System Option

[Over view]
Change following system option when the system operates.

<I> Spare Disk Recovering ---—-- Select the performance density when data is copied to a spare disk.
(correction copy and drive copy)
* Interleave : Everytime 4-slot copy is completed, copy job sleeps for the
time dependent on load of HOST I/O.
» Offline : No sleep. (No considering HOST job)

NOTICE
Please do not use if no channel paths is varied offline.

<2> Disk Copy Pace -----------—-- Specification of copy pace is supported with the “Interleave” mode at Spare
Disk Recovering. 3 modes are supported.
* Medium : Optimization mode. The copy time depends on load of HOST

1/0.
= Faster : Copy job is prior to HOST job.
* Slower : HOST job is prior to copy job.
<3> Dynamic Sparing «------—--—-- Copy automatic to a spare disk if disk failure exceeded the threshold value.
* Do : When failure occurs, drive copy is executed automatically.

Also drive copy can be started by SVP operation.
* Do not : Drive copy can be executed only by SVP operation.

<4> Correction Copy --------------- Execute correction copy to a spare disk automatically when one drive has
blocked.

* Do : When failure occurs, correction copy is executed
automatically. Also correction copy can be started by SVP
operation.

* Do not : Correction copy can be executed only by SVP operation.

Note) You can not select “Do” at Dynamic Sparing and “Do not” at Correction Copy at the same time.

<5> Bus Mode Select the bus mode.
* Sequential mode
« Transactional mode
<6> High Speed Adapter Check -- After change all CHA/DKA to high speed adapter, check to insert non-high
speed adapter in DKC.
*Do : Issue warning message, if insert non-high speed adapter.
* Do not : No check.
<7> Option Install ----------------—- Install a feature Option. (See 10.3 Option Install).

(1) Select (DC) the [Online] icon in the ‘SVP’ window.
B > o
5 B

Information Status Diag

Fdcopy Install

Copyright ©1995,1998, Hitachi, Ltd.
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(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright (C) 1994,1995,Hitachi,td.

OK

(3) Select (CL) the [Mode] menu in the “Maintenance Online’
window and select (DR) [Modify].

Maintcoance Onling

File  Maintenance QO

(4) Select (CL) the [Maintenance] menu in the ‘Maintenance
Online’ window and select (DR) [System Option)]. I vitcnr [

Hurdware Maintsnsnce
Sofware Malsteaance: »

Logical Davics Muleiensnce_.

Jeniag parameier
Online Pech B

Lhenge Subsystam ¥

(5) Select (CL) the desired item in the ‘System Option Setup’
dialog box, and select (CL) [OK].

Spate Disk Recovering Dynamic Sparing

@© |nterleave ®Do O Donot
O Otfline
Correction Copy

Disk Copy Pace ©®Do  ODonot
© Madium )

OF High speed adapter check

& ODo @ Donot
O Slower
| Dption Instal
Bus mode

O Sequential mode
© Transactional mode

Copyright ©1995,1997, Hitachi, Ltd.
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(6) If you want to change system option in the ‘System
Option’ dialog box, select (CL) [OK]. = System Option

Are you sure you want to change system option

in DKC?

(7) The message is displayed in the ‘Hardware Maintenance’

dialog box. Hardware Maintenance

Changing the subsystem configuration data...

(8) Select (CL) [OK] in the ‘Hardware Maintenance’ dialog
box, in order to finish processing. Hardware Maintenance

0 Subsystem configuration data was changed.

(9) Close the ‘Maintenance Online’ window.

Copyright ©1995,1996, Hitachi, Ltd.
| Rev.2 [ uu1995 [Nov.1905 [ Feb.1096] | [ [ SVP02-760
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10.2.17 Recovery Procedure for Bus

(1) Select (DC) the [Online] icon in the ‘SVP’ window.

Information Status Diag

Instal

(2) Select (CL) [OK] in the ‘SVP”’ dialog box.

Copyright [C) 1994,1995,Hitachi,Ltd.

(3) Select (CL) the [Mode] menu in the ‘Maintenance Online’
window and select (DR) [Modify].

=
| Eile_Muaintenance [T

Maintenance Online

(4) Select (CL) the [Maintenance] menu in the ‘Maintenance

Online’ window and select (DR) [Hardware AN Maintcnance [ETT0
Maintenance]. Sotware Malntensnce >
Logical Device Maintensnce...
System Option...
Tuning psrameter
Dnline Puich ¥
Change Subsystem »

Copyright ©1995,1996, Hitachi, Ltd.
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(5) ‘Hardware Maintenance’ is displayed.

— T S -
File Maintenance
- Hardware Maintensnce [~
Name Status Name Status Name Status

@MainPlatter INORMAL '  OHDU-R10 WNORMAL | O HDU-LIO [EMPTY
O Cache Box1 EMPTY | OHDURI! NORMAL ] O HDULIT [EMPTY
O Cache Box2 [EMPTY | O HDUA1Z [NOAMAL | O HDWUH12 [EMPTY
QO Others O HDU-R1I INORMAL | O HDUI3 [EMPTY
OHDURI4 [EMPTY | O HDUH14 [EMPTY
OHDURIS [EMPTY | O HDULIS [EMPTY
O HDU-RIE [EMPTY | O HDUHL16 [EMPTY
OHDUAIT [EMPTY | O HDUL1T [EMPTY

(6) Select [Others] from ‘Hardware Maintenance’ (CL)

Maintenance Online

/| Wi
and select [Maintenance] from [Maintenance] (DR). e R
g Mmnlenhance Hardwate Mainienance
Name Status Name Status Neme Status
O MainPistter [NORMAL | OHDURID INORMAL 1 OHDULIO [EMPTY |
O Cache Box1 [EMPTY | O HDU-RIT [NORMAL | OHDULN [EMPTY |
QO Cache Box2 [EMPTY | O HDU-RIZ [NORMAL } O HOULIZ2 IEMPTY |
@Others | OHDURII NORMAL |  OHDUHLII [EMPTY |
O HDU-RIA TEMPTY | O HDUHL14 [EMPTY |
O HDU-RIS [EMPTY | O HDUHLIS [EMPTY |
OHDURIE [EMPTY | O HDULIS [EMPTY |
O HDUAIT [EMPTY | QHOWIT [EMPTY |

(7) “Reading configuration...” is displayed.

"OTHERS

Reading configuration...

(8) Select [Cluster...] (CL) from ‘Cluster’ group box in

. , i ) oTHEnS
OTHERS’. —
L ) Noms Nomar Sladue
® T el O paiconn O PWRCTL1  INDRMAL)
Q EPO SW Oncucons O PWRCTL2 INDRWAL)

O Sysampenet O LTM PORAT
QoPpanett OLIHPCAD
OoPpanatz  Osw

O Outist bem QO ssve

O RS coNN

Parts etatus Parts slobuz
PMORMAL)

Copyright ©1995,1996, Hitachi, Ltd.
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(9) Select blocked bus [XXXX] (see STATUS section) from
“parts list’ group box (CL) and select [Recover] (CL).
Valid [XXXX] values are listed below.

I CLUSTER I

Parts list

« [M-BUS] e M.BUS OWEUS O Chustor! O Cache Box1 | =
' . OCFBUSM O Clusterr2 O Cache Box-2
[F-BUS/H] ---- F-BUS (High) O F-BUS/L
* [F-BUS/L] ----- F-BUS (Low) Hhoek I Hecoy_elj

(10) Select [Yes] (CL) in response to “Do you want to recover

000"
XXXX represents one of the bus names listed in step
®. 9 Do you want to recover M-BUS?

(11) Select a processor that execute bus access test, and select

[TeSt] (CL) Select processor, and press “Test.”
If you select [Cancel], Bus Recovery is executed without Bus e
. . g @EHPRIE] O DKP8-1G
Access Test and the result (13) in SVP02-800 is displayed. OHPIE O DRPO-IN
O rap2tF - O DRPAYS
OrupatF O DKPB.IK
Ouowpazm  Opxpea
Oopsan O okrpp-2M
QOreR O DKPE-A
Orupz2rn O DKPF-2P
(et ]

BUS ACCESS TEST

(12) Bus access test has finished normally, and the result is displayed.

Processor =---=========- Processor name selected in step (11).
Bus access test-------—- OK : Failure has not occurred. Procossor: CHPB-1E
NG . Fallurc has OCCllITCd M-BUS F-BUS[HIGH) F-BUS{LOW]
L * Bus test
** - Memory is blocked. ais : oK o
. . SM A 0K - oK
-- : This term is not tested. SN B oK - oK
. . Waming check
Warning check (*1) -- OK : Warning has not occurred. SMPCHKERR: DK - oK
. SMP BUSOPEN : oK - -
* NG : Warning has occurred. BSA CHKERR : - oK oK
. . BSABUSOPEN: - oK oK
-- . This term is not checked. BSA LIVEINS ; 4 oK oK
*] When warning check is not supported, all columns are “--". Recover:  Exscule recovering bus
Test agam : RAstum to selecling processor
Canceal : Cancel recovering bus
Recover [ Ileﬂagain ] L Lancel l

Copyright ©1995,1996, Hitachi, Ltd.
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If blocked bus isn’t a failure part, you select [Recover] and recover the bus.

Refer to the following table:

“Patterns of bus access test result and guessed failure parts” (SVP02-800 ~ 802).

If you select [Recover] (CL), go to (13).
If you select [Test again] (CL), go to (11).
If some errors have occurred at bus access test, go to (11).

(13) Select [OK] (CL) in response to “The restore has finished.”.

If an error has occurred, the message “The restore has failed.”
is displayed as shown on the right.

return to TRBL05-20.

o The restore has finished.

Patterns of bus access test result and guessed failure parts

| Rev2 ||0ct.1995|var.1996|way.1996[

Pattern Failure Part
MBUS FBUS H FBUS L 1.Nothing
CMA * OK OK
1 CMB * OK OK
SMA OK * OK
SMB OK * OK
MBUS FBUS H FBUSL 1.F/H failure
CMA * NG OK
2 CMB * NG OK
SM A OK * OK
SM B OK * OK
MBUS FBUS H FBUS L 1.F/L failure
CM A * OK NG
3 CMB * OK NG
SMA OK * NG
SMB OK * NG
MBUS FBUS H FBUS L 1.M BUS failure
CMA * OK OK |
4 CMB * OK OK
SM A NG * OK
SMB NG * OK
Copyright ©1995,1996, Hitachi, Ltd.
[ [ , SVP02-800
|



K6600890-

Pattern

Failure Part

MBUS FBUS H FBUS L 1.CACHE A failure
CM A * NG NG
5 CMB * OK OK
SM A OK OK
SMB OK OK
MBUS FBUS H FBUSL 1.CACHE B failure
CMA * OK OK
6 CMB * NG NG
SM A OK OK
SMB OK OK
MBUS FBUS H FBUS L 1.Shared Memory A failure
CM A * OK OK
7 CMB * OK OK
SM A NG * NG
SMB OK * OK
MBUS FBUS H FBUS L 1.Shared Memory B failure
CMA * OK OK
8 CMB * OK OK
SM A OK * OK
SMB NG * NG
MBUS FBUS H FBUSL LF/H failure
CM A * NG OK (2.CHACE A failure)
9 CMB * OK OK
SM A OK * OK
SMB OK * OK
MBUS FBUSH FBUS L 1.F/H failure
CMA * OK OK (2.CACHE B failure)
10 CMB * NG OK
SM A OK * OK
SMB OK * OK
MBUS FBUS H FBUS L L.F/L failure
CM A * OK NG (2.CACHE A failure)
11 CMB * OK OK
SM A OK * OK
SMB OK OK
MBUS FBUS H FBUSL 1.F/L failure
CM A * OK OK (2.CACHE B failure)
12 CMB * OK NG
SM A OK * OK
SMB OK * OK
MBUS FBUS H FBUS L 1.F/L failure
CMA * OK OK (2.Shared Memory A failure)
13 CMB * OK OK
SM A OK * NG
SMB OK OK

Copyright ©1996, Hitachi, Ltd.
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Pattern Failure Part
MBUS FBUS H FBUS L 1.F/L failure
CMA * OK OK (2.Shared Memory B failure)
14 CMB * OK OK
SM A OK * OK
SMB OK * NG
MBUS FBUS H FBUS L 1.M BUS failure
CMA * OK OK (2.Shared Memory A failure)
15 CMB * OK OK
SM A NG * OK
SMB OK * OK
MBUS FBUS H FBUS L 1.M BUS failure
CMA * OK OK (2.Shared Memory B failure)
16 CMB * OK OK
SM A OK * OK
SMB NG * OK
MBUS FBUS H FBUSL 1LF/L failure
CMA * OK NG
17 CMB * OK NG
SM A OK * OK
SM B OK * OK
MBUS FBUS H FBUS L 1.F/L failure
CM A * OK OK
18 CMB * OK OK
SM A OK * NG
SMB OK NG

* If warning check “NG” occurred, see “Error Recovery Procedure for Warning SIM” (TRBL05-300).

Copyright 1996, Hitachi, Ltd.
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10.2.18 Blocking of Cluster

NOTICE

This is a special (exceptional) operation. Ask the technical support center about the appropriateness of the operation.

(1) Select (DC) the [Online] icon in the ‘SVP’ window.

ﬁ

Information Status Diag

Fdcopy Install

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright [C] 1994,1895,Hitachi,Ltd.

0K

(3) Select (CL) the [Mode] menu in the “Maintenance Online’

window and select (DR) [Modify].

(4) Select (CL) the [Maintenance] menu in the ‘Maintenance
Online’ window and select (DR) [Hardware

Maintenance].

AN Mainlean:

Hardwears Maibiani:

Mainlenanie Unline

Software Malntenanca [
Logicsl Device Malntenance...
System Qp¥on...

Juning parameter

Online Patch ¥
Lhange Subsystem L

Copyright ©1996,1998, Hitachi, Ltd.
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(9) Start of Cluster block

Select [Cluster-1] or [Cluster-2] from ‘CLUSTER’ [ cwser |

(CL), and select [Block} (CL). Pauts ist

OuBUS @Tusteri O Cache Box-1
OFBUSH O Cwster-2 O Cache Box-2

| © FBusa
| Block Ifﬂm!en

(10) Beginning Block
* When only serial or parallel channels, or they are mixed.
Select [Yes] (CL) in response to “Please confirm you - ml
have already varied off the concem;d channel path(s). Picase confirm you have already varied off the

. O concerned channel path{s).
Do you want to block xxxxx?". Do you want to block Cluster-1 ?

LYes | [ |

» When SCSI channels and other kinds are mixed.

Select [Yes] (CL) in response to “Please confirm vou ml

have already varied off the concerned channel path(s). [SPC2148])
Please confirm you have already shutdown concerned Please confirm you have already varied off the
connecting SCSI host(s) or switched to the alternate 6 concerned channel path(s).

" Please confirm you have already shutdawn
SCSI channel path(s). Do you want to block xxxxx?". concerned connecting SCS! host(s) or switched

to the alternate SCSI channel path(s].
Do you want to block Cluster-1 ?

Lyes | (e ]

* When only SCSI channels are installed.
Select [Yes] (CL) in response to “Please confirm you “I
have already shutdown concerned connecting SCSI [SPC2149])

host(s) or switched to the alternate SCSI channel path(s). Please confirm you have already shutdown

Do you want to block xoxx?”. concemed connecting SCS! host(s) or switched
to the alternate SCSI channe! path(s).
Do you want to block Cluster-1 ?

Valid xxxoxcx values are listed below. Yes
¢ Cluster-1
¢ Cluster-2

Copyright ©1996,1997, Hitachi, Ltd.
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Iﬂeading configwration...

(11) Processing to Cluster block.

“Reading configuration...”

“Blocking cache memory...”

“Blocking shared memory...”

“Blocking Bus...”

“Changing Bus arbiter...”

“Blocking CHA...”

“Blocking DKA...”

“Blocking CHP...”

“Blocking DKP...”

“Blocking DKC-SVP communication...”
“Blocking Cluster failure report...”
“Processing to disable the environment check...”
“Blocking SVP-SSVP communication...”

(12) End of Cluster block
Select [OK] (CL) in response to “The blockade has finished.
Cluster is blocked.”.

The blockade has finished.
Cluster is blocked.

Copyright ©1997, Hitachi, Ltd.
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10.2.19 Recovering of Cluster
Note : Before recovering of Cluster, please reboot PC.

(1) Select (DC) the [Online] icon in the ‘SVP’ window.

Information Status Diag -
chopy Install i |I|nv

(2) Select (CL) [OK] in the ‘SVP’ dialog box.
SVP

Copyright [C]) 1994,1995,Hitachi,Ltd.

OK

(3) Select (CL) the [Mode] menu in the ‘Maintenance Online’
window and select (DR) [Modify]. ; ——

(4) Select (CL) the [Maintenance] menu in the ‘Maintenance
Online’ window and select (DR) [Hardware

Mainlcnane

Harthware Maimteian ¢
I [ . Heotvare Malmenance ¥
te CC] ' Legical Device Meimenance...
Byutem Qption...
Jening porsmeter
Dnline Petch ¥
Lhange Subsystem »

Copyright ©1996,1997, Hitachi, Ltd.
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(5) ‘Hardware Maintenance’ is displayed.

Hatdwars Maintensnce

Name Stams Nome Stae Heme Stalus
©QainPistzr INORMALY ~ OHDURIO NORMAL |  ONDULIO [EMPTY |
O Coche Bex1 [EMPTY | OHDURIY MNORMAL |  OHDULI! EMPTY |
O Cache B2 [EMPTY | OHDURIZ MORMAL | O HDULL12 EMPTY |
O Owvers QHDU-RI3 INORMAL | O HOUHLIZ EMPTY |

OCHDURIA EMPTY | OHOULI4 EMPTY |
O HDURIS [EMPTY O HDUHLIS EMPTY |
1
1

1
OHOURIE EMPTY | O HDUHL16 FEMPTY
1

QO HDURIT EMPTY O HOULI? EMPTY

(6) Select [Others] from ‘Hardware Maintenance’ (CL)
and select [Maintenance] from [Maintenance] (DR).

Maintenance Uinline

File JF BTURSTTTRS

Hardware Mainirnanee

Name Status Nome Stowss Nome Status
O MainPiotier INORMAL ) OHOURIE MORMAL | O HDULIN EMPTY
O Cache Bext EMPTY | OHDURI! MORMAL | O HOULII EMPTY
O Coche Bex2 EMFTY | O HDURIZ MORMAL | OHOULIZ EMPTY
®otham ) OHDURI3 MORMAL | O HDUALIY EMPTY

OHDUANA EMPTY | O HOUHLI4 EMPTY

OHDURIS [EMPTY |  OHDUHLIS [EMPTY
O HOUAIS [EMPTY | QHOULIS [EMPTY
OHDURIT EMPTY |  OHDURLIT [EMPTY

(7) “Reading configuration...” is displayed.

Reading configuration...

(8) Select [Cluster...] (CL) from ‘Cluster’ group box in
‘OTHERS’.

= h‘- o= L] B Lm

O smd Oricom  OPwreit1  PlORMALY | E |
Oroww Oncom  OrwmcTia  PIORMAL]
Otpumamed OLTHPGAX

Oorpastt OLIMPFBER T —
Otrpeiz Osw
[«] (o] i
T Guem =] ||==
rDR- DELI— rper BOLA1 — oA —
,m._’ﬂ (mugs]' = [
Pusts etaten Pema cemn Pose sase Pata pmman Pasts statn
et BHORMAL)
POMAL)
[
PORMAL]

Copyright ©1886, Hitachi, Ltd.
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(9) Start of Cluster recover

Select [Cluster-1] or [Cluster-2] from ‘CLUSTER’
(CL), and select [Recover] (CL).

[T |

Parts kst

OMBUS @ Guster-i, O Cache Box-1
OFBUSMH O Cwster-2 O Cache Box-2
Q FBUSA

(10) Beginning Recover

Select [Yes] (CL) in response to “Do you want to
recover xxxx?”.

Valid xxxx values are listed below.

* Cluster-1
* Cluster-2
If Cluster 1/2 is fail. Goto(11)
If Cluster 1/2 is blockade. Go to (14)
If Cluster 1/2 is normal. Go to (15)

m

(11) Confirm varied Off-line.

» When only serial or parallel channels. or they are mixed.

Select [OK] (CL) in response to “This operation will
block xxxxx before recovery. Please confirm vou have
already varied off the concerned channel path(s). Do vou
want to continue?”.

= When SCSI channels and other kinds are mixed.
Select [OK] (CL) in response to “This operation will
block xxxxx before recovery. Please confirm vou have
already varied off the concerned channel path(s). Please
confirm you have already shutdown concerned
connecting SCSI host(s) or switched to the alternate
SCSI channel path(s). Do you want to continue?”.

B

This operation will black Cluster-1 before

recovery.

9 Please confirm you have aiready varied off the
concerned channel path(s].

Do you want to continue ?

[0k | [Cancer

B ohes ||
[SPC21501)

This operation will block Cluster-1 before
recovery.

Please confirm you have already varied off the
concerned channel path(s).

Piease confirm you have aiready shutdown
concerned connecting SCS| host(s) or switched
to the afternate SCSI channet path(s].

Do you want to continue ?

Copyright ©1996,1997, Hitachi, Ltd.
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» When only SCSI channels are installed.
Select [OK] (CL) in response to “This operation will | =N S

block xxxxx before recovery. Please confirm vou have [SPC21511]
already shutdown concerned connecting SCSI host(s) or This operation will block Cluster1 before
switched to the alternate SCSI channel path(s). Doyou |- g recovery.

. - Piease confirm you have already shutdown
want to continue?”. concerned connecting SCSI host[s) or switched
to the altemate SCSI channel path{s).

Do you want to continue ?

Valid xxxxx values are listed below. | ok | [Cancei
* Cluster-1
* Cluster-2

Copyright ©1897, Hitachi, Ltd.
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(12) Processing to Cluster block.

“Reading configuration...”
“Checking status of Cluster...”
“Blocking Cluster...”

“Blocking cache memory...”
“Blocking shared memory...”
“Blocking Bus...”

“Blocking OP-Panel...”
“Changing Bus arbiter...”
“Blocking CHA...”

“Blocking DKA....”

“Blocking CHP...”

“Blocking DKP...”

“Blocking Cluster failure report...”
“Processing to disable the environment check...”

Reading configuration._.

(13) When redundant PS is not installed, select [OK] (CL)

response to “Please execute following.
1.Turn off Breaker Box-X. 2.Turn on Breaker Box-X.
3.Press ‘OK’.”.

When Logic Redundant PS is installed, and Add Cache
Box is not installed, select [OK] (CL) response to “Please
execute following. 1.Switch MPS in Cluster-X to
DISABLE. 2.Switch them to ENABLE. 3.Turn to
"CHK RST" the "CHK RST/IND TEST" Sw on "CE
panel." 4.Press 'OK'.”.

When Add Cache Box is installed, and Logic or Cache

Redundant PS is installed, select [OK] (CL) response to
“Please execute following. 1.Switch MPS in Cluster-X

and PSs in Cache Box-X to DISABLE. 2.Switch them to
ENABLE. 3.Turn to "CHK RST" the "CHK RST/IND

TEST" Sw on "CE panel." 4.Press 'OK'.”.

Valid X values are listed below.
* Cluster-1 -1
 Cluster-2 -2

Please execute following.
1.Tum off Breaker Box-1.

2.Turn on Breaker Box-1.
3.Press 'OK'

OK

Please execute following.

1.Switch MPS in Cluster-1 to DISABLE.
2.Switch them to ENABLE.

3.Turn to "CHK RST" the “CHK RST/IND TEST"
Sw on *'CE panel.”

4.Press ‘OK'

B

Please execute following.

1.Switch MPS in Cluster-1 and PSs in Cache
Box-1 to DISABLE.

2.Switch them to ENABLE,

3.Turn to “CHK RST" the "CHK RSTAIND TEST"
Sw on “’CE panel."

4.Press "OK'

Copyright ©1996, Hitachi, Ltd.
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Reading the environment monitor...

(14) “Reading the environment monitor...” is displayed.

(15) Processing to Cluster recover.

“Reading configuration...” Reading configuration...
“Checking status of Cluster...” I

“Restoring Cluster...”

“Waiting for restart...”

“Restoring DKC-SVP communication...”
“Restoring DKA...”

“Restoring DKA (SCSI Path)...”

“Restoring DKP Path...”

“Restoring CHA...”

“Restoring Cluster failure report...”

“Restoring Bus...”

“Restoring shared memory...”

“Restoring cache memory...”

“Processing to enable the environment check...”

!

Copyright ®1996,1997, Hitachi, Ltd.
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(16) End of Cluster Recover
* When only serial or parallel channels, or they are mixed.

Select [OK] (CL) in response to “The restore has
finished. Cluster is enabled. The concerned channel
path(s) are available. Please vary the path(s) on.”.

* When SCSI channels and other kinds are mixed.
Select [OK] (CL) in response to “The restore has
finished. Cluster is enabled. The concerned channel
path(s) and SCSI channe] path(s) are available. Please
vary the path(s) on.”.

* When only SCSI channels are installed.

Select [OK] (CL) in response to “The restore has
finished. Cluster is enabled. The concerned SCSI
channel path(s) are available.”.

bw  Othes ]
The restore has finished. Cluster is enabled.

The concemed channel path(s) are availabie.
Please vary the path{s) on.

[SPC2154]1)

o The restore has finished. Cluster is enabled.
The concerned channel path[s} and SCSI
channel path{s) are available.
Please vary the path[s] on.

[SPC2155]]

0 The restore has finished. Cluster is enabled.
The concerned SCSI channel path{s) are

available.

Copyright ©1996,1997, Hitachi, Ltd.
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10.2.20 Parallel Configuration

(1) Select (DC) the [Online] icon in the ‘SVP’ window.

Information Status Diag

Fdcopy Instal

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright [C] 1994,1995,Hitachi,Ltd.

(3) Select (CL) the [Mode] menu in the ‘Maintenance Online’

window and select (DR) [Modify).
o View r

(4) Select (CL) the [Maintenance] menu in the ‘Maintenance

Online’ window and select (DR) [Parallel Configuration...]. = Maintenance Online [~1-1]
File BEEGULELTE Mode

Hardh Maint -

Software Maint -3 »

Logical Device Maintenance...
System Option...

Tuning parameter

Online Patch »

Change Subsystem 3
Paralle! Configuration...

Copyright ©1996, Hitachi, Ltd.
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(5) Set parallel channel configuration

Define the device configuration information from ‘Channel

Configuration’.
After setting up all items, select [OK] (CL).

After setting up all channel adapters, the next message is displayed.

ASHB/e & Device Ad

A
|-D-nd5nut

Charead i
’-&-Inlw [45M8/0 [2] Device Addess: 00 |

" Charesl C
‘&-—d“kv'—hﬁuw|

Exr—r—ri| i

Co] e

©

Confirm installation of the configuration
Select [Yes] (CL) in response to message “Are you sure
you want to install the changed configuration?”.

- Parallel Configuration

Are you sure you want to install the changed
configuration?

@)

Replace CHAs

After installation of the configuration, message “Please
replace the parallel CHAs.” is displayed.

Select [OK] (CL) in response to the message, replace
CHAs. (See REPLACE SECTION)

- Parallel Confiquration

Please replace the paraliel CHAs.
The new configuration will be avallable sfter the

replacement.

Copyright ©1996, Hitachi, Ltd.

0 o

SVP02-890




K6600890-

10.2.21 Parity Error indication

Prerequisite operation
(1) Select (DC) the [Information] icon in the ‘SVP’ window.

Saus  Dig

.@

Fdcopy Install Oniine

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright (C) 1994-1996,Hitachi,Ltd.

oK

(3) Select (CL) the [View] menu in the ‘Information’
window and select (DR) [Parity Error...]

Copyright ©1996, Hitachi, Ltd.
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(4) LDEV to exist parity errors is displayed. Select (CL)
LDEYV to be indicated in the “Parity Check Volume’
dialog box and select (CL) [Detail...].

Logical Device

(5) Detail of parity errors.
(When “No.” exist more than 17, select (CL) [Next].)

Logical Devica : 01

Reazen PDEVH

No CC HH
1 O7BE-00
2 070A-00

- HDD-R100
—_ HDD-A100

Check Dats : 1398-03-06 22-54:00
S
T HH

O7BE00  OZE®S || dunt |
TEEDD OTvEes

UIPEC W b=

(6) Select (CL) [Close] in the ‘Detail’ dialog box.
Select (CL) [Close] in the “Parity Check Volume’ dialog box.
Close the ‘Information’ window.

Copyright ©1996,1998, Hitachi, Ltd.
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10.2.22 PCB Revision Display

(1) Select (DC) [Install] icon in the ‘SVP’ window.

5 O

Infarmation Status Diag

Fdcopy Online

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

SVP

Copyright (C) 1994-1936,Hitachi,Ltd.

OK

(3) Select (CL) the [Install] menu in the ‘Install’ window and
select(CL) [PCB Revision Display...].

Install

Flle BOEFIIN Mode

Define Configuration and Install...
Refer Configuration...

System Tuning...

Logical Device Format...

Manual Dump...

MP Install...

System Time...

Set IP Address...

PCB Revision Display...

(4) ‘Reading’ is displayed.

SVP is reading PCB revsion.

Please wait...

Don't switch Application.

Copyright ©1996, Hitachi, Ltd.
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(5) PCB Revisions are displayed.

Meaning of comments in the PCB Name.

- Cluser 1
R — *s Location PCB Name
Revision data isn’t written on this PCB. ::::E
‘Not Installed’ ; PLG WP022-A
PCB isn’t installed on this location or PCB on this PLH Wp022- A
location is failed PLJ Not installed
0 § Iailed. PLK WPO21-A
‘Not Supported’ ; =
- Cluser
This PCB’s main micro doesn’t support the function of Location PCB Name Rev  PB Rev

‘PCB revision display’. WP022- A J
WrO22-A J
WPO22-A J
WP022-A J
WP021-A G

G

WP021-A

(6) Select(CL) [Close] in the ‘PCB Revision Display’ dialog box.

(7) Close the ‘Install’ window.

Copyright ©1996, Hitachi, Ltd.
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10.2.23 Blocking of Cache Box

NOTICE
This is a special (eXceptional) operation. Ask the technical support center about the appropriateness of the operation.

1
ﬁ

Infarmation Status Diag

Fdcopy Install

(1) Select (DC) the [Online] icon in the ‘SVP’ window.

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright (C) 1994,1995,Hitachi,Ltd.

OK

(3) Select (CL) the [Mode] menu in the “Maintenance Online’ -
window and select (DR) [Modj_fy]. [= Mainirnance Online

Elle Maintenance

(4) Select (CL) the [Maintenance] memu in the “Maintenance
Online’ window and select (DR) [Hardware

Maintenance Unling

Maintenance]. Softwara Malnianance ¥
Logical Device Maintenance...
System Qption...
JTuning parameter
Online Patch ¥
Lhange Subsy b

Copyright ©1996,1698, Hitachi, Ltd.
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(5) ‘Hardware Maintenance’ is displayed.
D e B

Eile Mewtensnce

T -1
Neme Status Nowve Stus Name Stetus
@MainPistic, FOAMAL ], OHDUAID INORMAL | O HOULIO [EMPTY |
O Cache Box) EMPTY | OHDURTT MNORMAL | OHDULIT [EMPTY |
O Cache Bax2 [EMPTY | O HOU-R12 NORMAL ] O HOULI2 [EMPTY |
O Others O HOUR13 NDRMAL | O HDULI3 [EMPTY |
O HDU-R14 [EMPTY | O HDU-L14 [EMPTY |
O HDURIS [EMPTY | O HDULIS [EMPTY |
O HDURIS [EMPTY | O HDU-LIE [EMPTY |
O HDU-RIT [EMPTY 1 O HOWLI? [EMPTY |

(6) Select [Others] from ‘Hardware Maintenance’ (CL)
and select [Maintenance] from [Maintenance] (DR).

[ E LR LSt s

OusiaPlotr NORMAL 1T O HDURI0 MORMAL 1 O HDULIS EMPTY |
© Cache Baxt EMPTY | CHOURIY MORMAL | OMDOULN [EMPTY |
O Cache Bax2 EMPTY | OMHOURT2 MORMAL | O HOULI2 [EMPTY |
S Qe OHDURI MORMAL T O HOLLI) EMPTY )
O HOURIA EMPTY | O HDULI4 [EMPTY 1
O HDURIE EMPTY | O HDULIS [EMPTY
O HDUR1E EMPTY | O HDULIE EMPTY |
O HDURIT EMPTY | OHDULI? EMPTY |

(7) “Reading configuration...” is displayed.

OTHERS

Reading configuration...

(8) Select [Cluster...} (CL) from ‘Cluster’ group box in
‘OTHERS’.

rPoo b f
Neme Rams L Shatn 'Ll

OWaem Orocows O PwRCTLT  SORMAL Crecs_] |
Qo sw Onucom  OmomcTL-2 PORMAL) |
O Smeppane OLTMPIIAX
Oorsmi1 OLiran

Chber
Qorpmet2  Osw
Outet Sen ssve
© g =] || (o==2]
rDRUAZ rosuLt DL mm—j = DL K2 = |
[DSU-IJ!ﬂ I IM-IH.IIE I | E I FDM!“EI |')lll-ﬂml. l
LT Pasts slates Parte slstus Purin shaben Pats slate |
| 1 Clmter1 moRRAL
toRmALl
Chmter2
MORMAL

Copyright ©1996, Hitachi, Ltd.

l REV.0 ||Dec1996| ] | | | I SVP02-950



K6600890-

(9) Start of Cache Box block

Select [Cache Box-1] or [Cache Box-2] from — ocwser .

‘CLUSTER’ (CL), and select [Block] (CL). Parts list
OusUs O Cumtor1 ®iEaTaaT) | —22=—
OFBUSH O Clustes2 O Cache Box-2

O F-BUS/L
| Block I | Recoyer I
=

(10) Beginning Block
Select [Yes] (CL) in response to “Do you want to block
xxx7”.

9 Do you want to block Cache Box-1 ?

Valid xxxx values are listed below.
» Cache Box-1
» Cache Box-2

(11) Processing to Cache Box block.
OTHERS
“Reading configuration...”
“Blocking Cache Box...”
“Blocking cache memory...”
“Processing to disable the environment check...”

(12) End of Cache Box block
Select [OK] (CL) in response to “The blockade has finished.
Cache Box is blocked.”.

The blockade has finished.
Cache Box is blocked.

Copyright ©1996, Hitachi, Ltd.
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10.2.24 Recovering of Cache Box

(1) Select (DC) the [Online] icon in the ‘SVP’ window.

Status

Information

Fdcopy Install

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright (C] 1984,1995, Hitachi,Ltd.

OK

(3) Select (CL) the [Mode] menu in the ‘Maintenance Online’ |
window and Select (DR) [Modify] Tt Mamlenance tinline nn

|

(4) Select (CL) the [Maintenance] menu in the ‘Maintenance
Online’ window and select (DR) [Hardware F

Mamienance Lialine

Maiutmaia: JYTS

Hardwares Maintenanre

Maintenance]. o Mo st M
System Qptien_.
Tuniag paremeter |
Online Peach »
LChange Subsywtem »i

Copyright ©1996, Hitachi, Ltd.
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(5) ‘Hardware Maintenance’ is displayed.

B
Name Stetws Neme  Stwe Neme  Statws
@ MUIDweL INOEMAL L,  OHDURIE NORMAL ]  OHDUHID [EMPTY |
O Cache Box1 EMPTY | OHDURIT MNORMAL T O HDULTY [EMPTY |
QO Cache Bax2 EMPTY | OHDU-mI2 pNOoRMAL | O HDUL1Z EMPTY |
O Others O HDU-RT3 INORMAL | OHDULI3 EMPTY |
O MDURTA EMPTY | O HOU-L14 EMPTY |
OHDURIS EMPTY | OMDHIS EMPTY |
O HDURIS EMPTY | O HDULIE EMPTY |
O HOURIT EMPTY | OHDULI7 EMPTY |

(6) Select [Others] from ‘“Hardware Maintenance’ (CL)
and select [Maintenance] from [Maintenance] (DR).

O MainPistcy ORMAL | OHOURIS NORMAL | O HDULIS [EMPTY

1

O Cache Bax1 [EMPTY | OHDURAIT MORMAL ] O MNDULI! EMPTY |
O Cache Bo2 [EMPTY | OHDURI2Z NORMAL | O HDULI2Z EMPTY |
Sidthers | OHDUAY NORMAL | O HDULII EMPTY |
O HOURTA EMPTY | O HDUL14 EMPTY |

O HDURIS [EMPTY | OHDULIS EMPTY |

O HDU-R1G [EMPTY | O HOULIE EMPTY |

O HDURI?T EMPTY | OHDUALI? EMPTY |

@) “Rwding' configuration...” is displayed.

Reading configutation...
(8) Select [Cluster...] (CL) from ‘Cluster’ group box in
0 RS". —— a— - S | =]
L & Oromm  Orwacnt oML
Ooosw Orucm Ormeniz POMA
OsSpunpme OLNMrAX
O 0F ponat? Oitroan Ot
Oorpmaz Oswr
| o= S == || =
DRUA2—] FDRUAT DEL "1 DL —] DRy AZ—
BKU. J |eaarp ]| [Caxe ] r’lmggl e
Portu stotm Pasta sttt ': :‘Mm im--
POORNALY
I -—
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(9) Start of Cache Box recover

Select [Cache Box-1] or [Cache Box-2] from ﬁw
“CLUSTER’ (CL), and select [Recover] (CL). Parts fist

OMBUS O Custer-1 @ iCache BonT'
OFBUS/H O Chuster-2 O Cache Box-2

O F-BUsS/L
Block | Recoyer |
(10) Beginning Recover

Select [Yes] (CL) in response to “Do you want to Others
recover xxxx?”.

0 Do you want to recover Cache Box-1 ?
Valid xo0xx values are listed below.
* Cache Box-1
* Cache Box-2

If Cache Box 1/2 is fail. Goto (11)
If Cache Box 1/2 is blockade. Go to (14)
If Cache Box 1/2 is normal.  Go to (15)

(11) Confirm message.
Select [OK] (CL) in response to “This operation will
block Cache Box-X before recovery. Do you want to

This operation will biock Cache Box-1 before

continue?”. recovery. Do you want to continue ?

Valid Cache Box-X values are listed below. Lox | [Conee]

» Cache Box-1 - c
* Cache Box-2

(12) Processing to Cache Box block.
OTHERS
“Reading configuration...”
“Checking status of Cache Box...”
“Blocking Cache Box...”
“Blocking cache memory...”
“Processing to disable the environment check...”

Reading configwation...

Copyright ©1996, Hitachi, Ltd.
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(13) Select [OK] (CL) in response to “Please execute following,

1.Switch PSs in Cache Box-X to DISABLE. B ohes g
2.Switch them to ENABLE. Please execute following.
" " " " 1.Switch PSs in Cache Box-1 to DISABLE.
3.Tumn to "CHK RST" the "CHK RST/IND TEST" Sw o 2.Switch them to ENABLE.
on "CE panel." 3.Turn to "CHK RST" the “CHK RSTAND TEST"
4 Press 'OK™. ahon “CE panel.
Valid Cache Box-X values are listed below.
« Cache Box-1
* Cache Box-2

(14) “Reading the environment monitor...” is displayed.

Reading the environment monitor. ..

Copyright ©@1996, Hitachi, Ltd.
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(15) Processing to Cache Box recover.
o |
“Reading Configuration...” Reading configuration...

“Checking status of Cache Box...” I

“Restoring Cache Box...”

“Waiting for restart...”

“Restoring cache memory...”

“Processing to enable the environment check...”

(16) End of Cache Box Recover
Select [OK] (CL) in response to “The restore has
finished. Cache Box is enabled.”.

O The restore has finished. Cache Box Is enabled.

Copyright ©1996,1997, Hitachi, Ltd.
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10.3 Option Install

This section describes how to install feature option.

10.3.1 HMBR Install/de-install

The view of HMBR is described in MULTIPLATFORM SECTION (See 21.7).
If you want to install this function, you need a special FD (DKC-F2101-M80).

Please prepare the FD. :

(1) Select (DC) the [Online] icon in the ‘SVP’ window.

B oo
B O

Information Status Diag

Fdcopy Instal

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

SVP

Copyright [C) 1994,1985,Hitachi,Ltd.

oK

(3) Select (CL) the [Mode] menu in the ‘Maintenance Online’

window and select (DR) [Modify].

(4) Select (CL) the [Maintenance] menu in the ‘Maintenance
Online’ window and select (DR) [System Option].

Copyright @1997, Hitachi, Ltd.
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(5) Select (CL) [Option Install]

Spare Disk Recovering Dynamic Sparing

@ Interisave C Do @ Danot
" Offime
. Lemection Copy
Disk Copy Pace Do € Domot
& Modmm
‘_l High speed adapter check
Faster C Do & Donot
€ Slower
{Option Install
s Bus mede
€ Segusntial mods
& Yransactionsl mode

(6) Insert Special FD (DKC-F2101-M80), and select (CL) [OK].
If you don’t have FD, select (CL) [Cancel].

[ONL21721)
This option needs special FD.
Please insert the FD.

[HMBR): Not Installed

oK [ Cancel |

(7) Select (CL) [OK].

HMER Function

Copyright (C) 1997, Hitachi, Ltd.

(8) If you want to install HMBR function check (CL) [On]

and select (CL) [OK]. Option Instsll
If you want to de-install HMBR function, check (CL) [Off], and HMBR
select (CL) [OK]. o
Install Go to step (10). “ 0| « off
De-install  Go to step (9).
OK I Cancel
Note : If you select (CL) [OK], the SVP will write the serial

number in the FD. Therefore, you have to select (CL)
[OK] in the ‘System Option’ setup screen (next step 11).

Copyright ©1997, Hitachi, Ltd.
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(9) Select (CL) [OK].

[ONL21701]

Are you sure you want to de-install the function ?

0K | [Cancel ]

(10) Remove FD. And select (CL) [OK].

Option Install

[onL21851)

Please remove the special FD.

(11) Select (CL) [OK].
] > |
' Spare Disk Recovering Dynamic Sparing
Note : If you set the HMBR option and selected [OK] in the & Interieave CDa & Dona
‘Option Install’ screen, you have to select. © OFtne

. Cornection Copy
Disk Copy Pace ©De C Donot
© Modium )
cF High speed adapter check
b CDe & Donot
€ Slower
Dption Install |
Bus mede
€ Segusntial mode
@ JTrarsactional mede

| Cancel

(12) If you want to change system option in the ‘System
Option’ dialog box, select (CL) [OK].

System Option

9 Are you sure you want to change system option
Note : If you set the HMBR option and selected [OK] in In DKC?

the ‘Option Install’ screen, you have to select.

[ ok | |cancel}

Copyright ®1997, Hitachi, Ltd.
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(13) The message is displayed in the ‘Hardware Maintenance’

dilog box

Changing the subsystem configuration data...

(14) Select (CL) [OK] in the ‘Hardware Maintenance’ dialog
' box, in order to finish processing. Hardware Maintenance

0 Subsystem configuration data was changed.

(15) Close the ‘Maintenance Online’ window.

Copyright ®1997, Hitachi, Ltd.
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